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Sazetak

Adobe Photoshop, program za manipulaciju slikom, razvijen je 1987. godine i ubrzo postaje
jedan od najpopularnijih programa te vrste na trziStu. [1] Godine 1998. tvrtka Adobe u
potpunosti otkupljuje program te od tada radi na njegovom razvoju, promociji i prodaji. Adobe
Photoshop danas nalazi svoju Siroku primjenu u raznim podrucjima, poput fotografije, grafickog
i web dizajna, video obrade i slicnih, zahvaljuju¢i svojoj Sirokoj paleti moguénosti i
funkcionalnosti koje program pozicioniraju kao standard mnogih industrija. llustracija je
podrucje stvaralaStva koje zazire u dvije discipline - likovnu umjetnost 1 graficki dizajn. Ona
putem medija vizualnog prenosi neku kontekstualiziranu poruku, a samom tekstu, poruci daje
dodatno interpretacijsko znacenje. llustracija kao disciplina nalazi svoju primjenu u brojim
podruc¢jima poput izdavastva, dizajnu i oglasavanju, noviskoj, filmskoj, industriji video igara i
sli¢no. Povijesno gledaju¢i svoju veliku popularnost ilustracija nanovo stje¢e s ulaskom u
digitalno doba kako racunalo ilustratorima pruza nove naine izrazavanja, prenaSanja ideja i
komuniciranja. Stvaranje digitalne ilustracije uklju¢uje dvije osnovne komponente — rac¢unalo i
program za obradu. Kao vodeci program za obradu slika, Photoshop svoju primjenu takoder
nalazi na podrucju ilustracije. Grafi¢ki tableti i slicna pomagala koja pretvaraju analogne tehnike
crtanja u digitalnu domenu, dodatno su pridonijeli Sirini moguénosti u domeni stvaranja

ilustracija.

Prakti¢ni dio rada opisati ¢e proces izrade digitalnih ilustracija za zbirku pjesama ,Budi mi
prijatelj* Karoline Perec u Photoshop-u kroz tehnicke aspekte rada u programu. Ovaj dio bazirati
¢e se na koracima u izradi — isprva skiciranje, potom izrada vanjskih linija, dodavanje boje,
detalja i1 sjena, dodatna podeSavanja te naposljetku i izvoz ilustracija - uz usporedno

objasnjavanje koriStenih alata i funkcionalnosti programa Adobe Photoshop.

Kljuéne rijeci: Adobe Photoshop, ilustracija, digitalna ilustracija, primjena Photoshopa u

ilustraciji



Abstract

Image manipulation software Adobe Photoshop was developed in 1987 and soon became the
most popular software of its kind on the market. In 1998 Adobe acquired Photoshop and since
then the company has been working on software development, promotion, and sales. Adobe
Photoshop finds its broad application in a number of different fields, including photography,
graphic and web design, video processing etc., thanks to its vast functionalities and the myriad of
tools which positions the software as an industry standard. lllustration, on the other hand, is a
discipline which exists enclosed by two great fields - graphic design and visual arts. The main
purpose of the field is delivering a contextualized message through the visual medium through
which illustration adds an additional interpretational meaning to a certain text. Illustration is
being applied in many fields including editorial, publishing, advertising, design, music, and film
industry. Historically speaking, illustration gained its considerable popularity by entering the
digital age — illustrators began to find new ways of artistic expression, conveying ideas and
means of communication. The core of digital illustration discipline is made of two components —
a computer and an image manipulation software. Photoshop has been a leading software in the
field of digital illustration for many years now and furthermore, gadgets like graphic tablets

contributed to the breadth of opportunities in the digital illustration domain.

This paper encompasses a project of creating digital illustrations of the Collection of Poems “Be
my Friend” by Karolina Perec using Adobe Photoshop. It describes technical aspects of
production by demonstrating the workflow from sketching, adding colors, details, and

adjustments to the illustration export.

Keywords: Adobe Photoshop, illustration, digital illustration, using Photoshop in illustration
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1. Uvod

Suvremeno doba, doba je svijeta dominiranog medijima, a digitalne tehnologije dokazuju koliko
je jak medij slike, ¢emu svjedo¢i i sklonost ljudi ka stvaranju, konzumiranju, dijeljenju i
komuniciranju vizualnim medijima. Kako slika govori vise od tisu¢u rije¢i, klisej je koji se
neobi¢no mnogo koristiti, no CovjeCanstvo, istrazivanja pokazuju, sve vise konzumira sliku
negoli tekst ili bilo koji drugi medij — slikom se covjek informira i educira, putem slike stvara
miSljenje 1 stavove, slikom komunicira i opisuje svijet oko sebe. Ovoj €injenici svjedoce brojni
internetski portali, druStvene mreze, blogovi, knjige i ¢asopisi, filmska i glazbena industrija,
poslovni svijet i promotivno okruZenje te nam pokazuje kako poseban odnos prema slici, kojeg
CovjeCanstvo njeguje od svojih najranijih dana, neée uskoro prestati, ve¢ Stovise, s ulaskom u

digitalno doba, samo jaca.

Priznati americki profesor i medijski teoreticar W.J.T. Mitchell, kako bi opisao suvremeni nacin
dozivljavanja slike, objasSnjava kako je temeljna znacajka slike da se prenosi s jednog medija u
drugi, a da je ra¢unalo to koje je ¢ak i jezik pretvorilo u sliku. Ra¢unalo je dalo novo svijetlo,
neCemu toliko starom kao slici, govori Mitchell. [2] | zaista, suvremena je vizualna kultura
oblikovana vizualnim medjima koji se stvaraju, organiziraju, dozivljavaju i dijele u pravilu
digitalno putem racunala. Ono je donijelo nove komunikacijske moguénosti, ali i mogucénosti

stvaranja tako nepovratno mijenjaju¢i medij slike.

Hardverska i softverska revolucija raCunala odigrale su naro¢ito veliku ulogu u na¢inu na koji se
stvara i dozivljava slika - brza, ja¢a i efikasnija racunala s kompleksnim programima sa $irokom
paletom moguénosti kreatorima su, ali 1 potrosa¢ima vizualnog sadrzaja, otvorili nove horizonte
u stvaranju i prenoSenju poruka, komunikaciji putem medija slike. U softverskom pogledu,
svakako se istice program Adobe Photoshop, koji je toliko popularan i zastupljen da kulturoloski
gledano nalazimo na poznavanje rijeci kao §to je ,photoshopirati ili nesto je ,photoshopirano®.
Kako ¢e u radu biti objasnjeno — Photoshop je jedan od programa koji je u potpunosti
revolucionirao vizualnu kulturu 1 svojevrstan je sinonim za digitalne medije. Svojim
funkcionalnostima i alatima, Photoshop iznova pomice granice u stvaranju, a njegova ga Siroka

primjena na podrucju manipulacije iobrade slika pozicionira kao standard brojnih industrija.

lako zaista Sirokog podru¢ja primjene, ovaj rad bazirati ¢e se na primjeni Photoshopa u
specificnom podrucju vizualne medijske komunikacije - ilustraciji. llustracija jest disciplina
stvaralastva, koja gotovo cijelo svoje postojanje egzistira izmedu dva velika podrucja — likovne

umjetnosti i grafickog dizajna — 1 nikada u potpunosti zapravo ne biva prihvac¢ena kao zasebna



disciplina. No, s ulaskom u 21. stolje¢e, kompjuterizacijom 1 digitalizacijom svega Sto se
digitaliziratida, s rastom broja i kvalitete digitalnih platformi, kako za izradu tako za promociju i
komunikaciju, disciplina ilustracije dozivljava svoj novi procvat. Koriste¢i digitalne alate,
suvremeni ilustratori nalaze nove naine stvaranja i izrazavanja slikom, $to ovu kreativnu
disciplinu ¢ini pogodnom za uposljavanje u raznim oblicima modernog nac¢ina komunikacije.
Zbog svoje sve vece primjene u raznim podru¢jima, ilustracija u 21. stolje¢u dobiva novu formu

ipozicionira se kao vazan medij vizualne medijske komunikacije.

Cilj ilustracije jest prenijeti neku poruku unutar nekog odredenog teksta, a njena se uloga u
komunikaciji manifestira kroz aktivno sudjelovanje ¢itatelja neke poruke jer ona daje dodatno
znaCenje tekstu, odnosno pruza bolje i1 dublje znacenje predmetu o kojem govori. Svoju
popularnost ilustracija stjeCe upravo u digitalno doba, a digitalna ilustracija kao takva svoju
primjenu nalazi u Sirokom spektru podrucja Sto svjedoCi vaznosti ilustracije kao suvremenog
medija vizualne komunikacije. Iako postoje razni nacini izrade ilustracije, upravo su digitalni
alati ti koji su ilustratorima stvorili novo polje u mogucénosti izrazavanja u kojem oni rado
eksperimentiraju i1 otkrivaju nove nain stvaranja i prenaSanja poruka. Photoshop se ovdje
iskazao kao mocan alat kojeg ilustratori rado koriste u izradi, upravo zahvaljuju¢i njegovim

brojnim alatima i naprednim moguénostima u obradi slika.

Rad se sastoji od dva vec¢a poglavlja — Teorijski dio i Prakticni dio te naposljetku i manjeg
poglavlja Analiza rezultata.

Poglavlje Teorijski dio sastoji se od tri cjeline — prva Adobe Photoshop daje uvid u program,
ukratko opisuje njegov povijesni razvoj u program kakvog poznajemo danas, objaSnjava njegove
alate i funkcionalnosti te podru¢ja njegove primjene, druga cjelina llustracija daje uvid u
podrucje i disciplinu ilustracije, u njene teorijske definicije te povijesni presjek razvoja i
shva¢anja ove discipline, objasnjava ulogu ilustratora i ilustratorske vjeStine, te analizira njezino
mjesto u digitalnom svijetu kroz podrucja primjene, te treéa cjelina Primjena Photoshopa u
ilustraciji objasnjava ulogu Photoshopa u ilustraciji, naro¢ito podrucju digitalne ilustracije, istice
najceSce koriStene alate programa u izradi te predstavlja graficke tablete koji sluze kao pomagalo

u pretvaranju ilustratorskih vjeStina u digitalnu domenu putem rada u programu.

Poglavlje Prakticni dio posveteno je procesu izrade digitalnih ilustracija za zbirku pjesama
,Budi mi prijatelj* Karoline Perec te konkretizira iznoSeno u teorijskom djelu rada kroz primjer
izrade ilustracije u Photoshopu. Poglavlje je podijeljeno na Cetiri cjeline — prva O zbirci pjesama
predstavlja zbirku pjesama i autoricu zbirke, druga Ciljevi rada definira ciljeve prakti¢nog

zadatka kroz analizu tema i motiva u odabranim pjesmama, tre¢a Metode i alati objasnjava

2



koriStene metode u izradi digitalnih ilustracija te daje presjek koristenih Photoshopovih alata pri
izradi te posljednja cjelina, Izrada ilustracija, opisuje cjelokupni proces rada kroz tehnicke

aspekte rada u programu prema unaprijed definiranim koracima u izradi.

Poglavlje Analiza rezultata kroz kriticko promisljanje evaluira uspjeSnost izrade praktickog

zadatka kroz referenciranje na pretpostavke iznesene u teorijskom dijelu rada.



2. Teorijski dio

Suvremeni mediji se dozivljavaju, kreiraju, editiraju, mijesaju, organiziraju i dijele u pravilu
digitalno. Od profesionalnih do amaterskih programa za izradu do alata za dijeljenje i interakciju
— svi oni mijenjaju na§ odnos prema najprisutnijem mediju danasnjice, vizualnom mediju, slici.

[3]

Photoshop je, neki se usuduju re¢i, jedan od tih programa koji je u potpunosti revolucionirao
vizualnu kulturu. Tako S$to je omoguc¢io digitalnu manipulaciju slikom, Photoshop je duboko
promijenio i oblikovao medij vizualnog. [4] On je postao svojevrstan sinonim za digitalne
medije, objasnjava teoretiar medija Lev Manovich u ¢lanku Inside Photoshop. Kao i nekolicina
drugih profesionalnih programa za editiranje slika, objaSnjava Manovich, Photoshop-ovi
izbornici sadrze na desetke razli¢itih naredbi, te ako znamo da svaka od tih naredbi sadrzi viSe
razli¢itih opcija koje omogucavaju joS dodanih naredbi koje ¢ine viSe razli¢itih stvari, dolazimo
do implikacije kako je kompleksnost koju mozemo posti€i u domeni vizualnog medija zaista

velika. [3]

Ako se govori 0 domeni vizualnih medija, negdje izmedu dva velika podrucja — likovne
umjetnosti i grafickog dizajna, smjestila se manja disciplina — ilustracija. llustracija se nikada u
potpunosti nije uklapala u jedno od ova dva podrucja i to zbog Cinjenice kako sadrzi znaCajke
oba smjera vizualnog stvaranja. llustracijom se naziva disciplina koja kroz umjesnost i vjestine
crtanja, za koje se kazu da pripadaju domeni likovnog izraZzavanja, komunicira neku
kontekstualiziranu poruku, §to zalazi u domenu grafi€¢kog dizajna. Stoga ilustracija ve¢i dio svog
zivotnog vijeka — a postoji ve¢ stoljeCima — ne biva prihvacena kao ozbiljna disciplina, do

zapravo relativno nedavno.

[lustracija svoj veliki preporod, ponovni interes 1 Siroku primjenu pronalazi upravo s ulaskom u
digitalnu eru zapocetu pojavom te popularizacijom raCunala i1 racunalnih tehnologija.
Moguénosti Photoshopa ostavile su svoj trag u brojnim disciplinama, a jednako vrijedi i za
podrucje ilustracije. Photoshop je potaknuo ilustratore da istrazuju nove nacine slikovnog
izrazavanja, isprva kroz manipulaciju slikama i eksperimentalnim nadinima izrazavanja u
zadnjem desetlje¢u 20., te potpunu adaptaciju i realizaciju moguc¢nosti ovog programa u 21.

stolje¢u kojeg pratimo do danas.

Prvo poglavlje teorijskog dijela stoga ¢e se osvrnuti na Photoshop kao program, ukratko ¢e
opisati njegov nastanak i povijest razvoja, objasniti ¢e njegovu primjenu i znacaj danas te ¢e

prikazati njegove mogucnosti kroz kratki pregled njegovih alata. Drugo ¢e poglavlje pak opisati
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ilustraciju kao disciplinu te se posebno dotaknuti podru¢ja digitalne ilustracije. Takoder ce
objasniti klju¢ne uloge, vjeStine i znanja ilustratora te istaknuti podrucja primjene ilustracije u
suvremenom svijetu. Posljednje, tre¢ce poglavlje osvrnuti ¢e se na koriStenje Photoshopa u

ilustraciji, objasniti znacaj programa i njegov utjecaj na ovu disciplinu.

2.1. Adobe Photoshop

Photoshop je software za manipulaciju slikama (engl. image manipulation software), odnosno
editor rasterske grafike (engl. raster graphic editor) [5][1][6]. ..Sa Photoshopom se mogu
stvarati te editirati slike i grafike kako bi prikazali §to god se moze zamisliti“, stoji na sluzbenom
web site-u tvrtke Adobe', koja od 1998. godine razvija i prodaje ovaj program. On omoguéuje
stvaranje slika i pruza Siroki spektar mogucnosti u radu s fotografijama, nalazi svoju primjenu u
grafickom 1 web dizajnu, dizajnu web aplikacija, omogucuje rad s videom i animacijama te 3D

sadrzajem. [6]

Photoshop je dostupan za Apple i Windows operativni sustav te posjeduje zasebnu file ekstenziju
psd ili .psb. Podrzava razlidite sustave boja" te alate za upravljanje tekstom i vektorskim
oblicima, 3D grafikama i videom. Moguénosti programa moguce je dodatno prosiriti
dodavanjem plug-in-ova koji se razvijaju neovisno te pruzaju korisniku nove ili poboljSane

znacajke programa. [1]

Uz Photoshop, razvija se 1 obitelj sli¢nih mu programa, brendirana kao ,,The Abobe Photoshop
Family“, a uklju¢uje Photoshop Elements, Photoshop Lightroom, Photoshop Express te
Photoshop Touch.™ Od 2013. godine Photoshop je, kao i drugi programi tvrke Adobe, sastavni
dio Creative Cloud sustava. Ovaj sustav korisnicima pruza pristup kolekcijama programa ovisno
0 namjeni i potrebama te se temelji na mjesecnoj supskripciji. Dakle, Photoshop, koji se nekada
prodavao kao zasebni program, sada je moguce koristiti na temelju mjeseCne supskripcije,
zasebno, ali i u paketu s drugim srodnim programima. lznos varira o odabranom planu od

US$9.99 do US$49.99 mjesec¢no. [1]

' Adobe ili Adobe Systems je ameriCka multinacionalna kompanija za razvoj racunalnih software-a. Jedni od
njihovih prvih proizvoda bili su PostScript, dig italni fontovi te lllustrator za obradu vektorske grafike

"RGB, CM YK, CIELAB, spot boje i duotone sustave boja
. Photoshop Elements namijenjen je pocetnicima te sadrzi jednostavnije opcije za editiranje, Photoshop Lightroom
omogucuje retu§iranje i organiziranje veceg broja slika, Photoshop Express je mobilna aplikacija koja omogucuje
editiranje slika i izradu kolaza,Photoshop Touch je aplikacija dizajnirana za tablete i druge touchsreen uredaje.



U svojih se 27 godina postojanja Photoshop nije prestajao razvijati i pratiti trendove ciljanih
industrija i potrebe korisnika, zahvaljuju¢i ¢emu ve¢ u svojim ranijim godinama postaje standard
industrije obrade i stvaranja slika. Zahvaljuju¢i svojoj Sirokoj paleti mogué¢nosti i velikom broju
alata, Photoshop ne prestaje prednjaciti na trziStu slicnih mu programa kojeg rado koriste i

profesionalci iamateri. [1]

2.1.1. Povijest nastankai razvoja Adobe Photoshopa

Adobe Photoshop broji vise od dva ipola desetlje¢a svog postojanja, a kako bi objasnili zacetke
njegovog evolucijskog puta treba se vratiti u 20. stoljece, to¢nije u 1987. godinu i to u, relativno
malen grad u americ¢koj saveznoj drzavi Michigan, Ann Arbor. [1] Ann Arbor najpoznatiji je
naime kao sjediSte SveuciliSta Michigan, ali i kao dom nadarene obitelji Knoll, ¢iji ¢e svestrani 1
talentirani ¢lanovi, braca Thomas i John, kasnih 80-ih godina poceti raditi na ideji razvoja

napredne aplikacije za obradu slika.[7][8]

Glen Knoll, otac dvojice djecaka i sveucili$ni profesor na SveuciliStu Michigan, imao je dva
hobija: racunala i fotografiju, ljubav prema dvije grane koju ¢e kasnije prenijeti na sinove-
Thomas se pocinje baviti fotografijom dok Johna zanimaju racunala [7][8]. 1987. godine
Thomas, sada PhD student na Sveucilistu Michigan piSe svoj prvi program na Macintoshu koji
pretvara grayscale sliku u monokromatski zapis na racunalu te ga naziva Display [1][7]. Display
privlaci Johnovu paznju, te on, kao zaljubljenik u racunala i zaposlenik tvrtke Industrial Light &
Magici, ubrzo uvida potencijal Thomasovog programa. Ubrzo braca pocinju suradivati na
njegovu razvoju, te samo godinu dana kasnije, zahvaljuju¢i Thomasovim naprednim
programerskim i Johnovim pragmatiénim dizajnerskim vjeStinama, lansiraju Image Pro,
napredniju aplikaciju sa mnogo vise mogucnosti nego je to bio slucaj s Display-em [1][7].
Krajem 1988. godine u tendenciji za komercijalizacijom programa, Thomas uspijeva sklopiti
ugovor s tvrtkom BarneyScan, koja ¢e zajedno sa svojim kupljenim skener uredajima

distribuirati njihov program za manipulaciju slika, sada nazvan PhotoShop'

'Industrial Light & Magic ili ILM je ameriCka tvrtka osnovana 1975. godine od strane Georga Lucasa specijalizirana
za izradu vizualnih efekata za filmsku industriju

" Jako su planirali zadrzati ime Image Pro, ime je ve¢ bilo zauzeto te su bili prisiljeni preimenovati program. lako je
u obzir dolazilo i ime PhotoHut naposljetku su izabrali ime PhotoShop (kasnije Photoshop)



Istovremeno John, uvjeren u komercijalnu vrijednost njihovog programa, putuje u Silikonsku
dolinu gdje ga demonstrira Apple-u i Russellu Brownu, art direktoru Adobe-a [1][7].
Pravovremenost je sve, pokazalo se, jer iako se Apple-u program jednako svidio, Russel Brown
ih uspijeva preduhitriti, te 1988. godine uvjerava Adobe u wveliki potencijal investicije u
Photoshop [9]. S velikim entuzijazmom Adobe otkupljuje licencu za distribuciju, a u potpunosti

¢e otkupiti program tek kasnije, kada je Photoshop postigao ogroman trzi$ni uspjeh. [9]

Prva verzija Photoshop-a, pod krovnim Adobe-om izlazi u velja¢i 1990. godine isklju¢ivo za
Macintosh uredaje. Od tada se Photoshop ne prestaje razvijati i postaje standard industrije i
nedvojbeno vodeéi program za obradu slika na globalnoj razini [5]. lako je Photoshop isprva
zamiSljen i do danas ostaje primarno orijentiran obradi slika, njegove su se mogucnosti sa
godinama razvoja pro§irile te je razvoj dodatnih alata omogucio Siru primjenu [5]. Razvoj alata i
moguénosti mozemo pratiti kroz njegove ranije verzije u periodu od 1990. do 2003. godine ,
preko prelaska Photoshop-a u Photoshop Creative Suite branding (CS) pa sve do predstavljanja
Photoshop Creative Cloud brandinga (CC) 2013. godine [1]. U Tablica 1prikazani su vazni
noviteti ialati pojedine verzije od 1990. do 2017. godine.

Tablica 1. Vazni noviteti i alati pojedine verzije Photoshopa od 1990. do 2017. godine

GODINA VERZIJA VAZNI NOVITETI | ALATI
IZDANJA

1990. Photoshop 1.0 Levels, Color Balance, Hue and Saturation,Curves, slikanje kistom

1991 Photoshop 2.0 Paths, Palette, CM YK paleta boja, pen alat, quickmask

1994, Photoshop 3.0 Layers
%
>
Z Adjusment layeri i Actions, unifikacija korisni¢kog sucelja s drugim
m
< 1996 Photoshop 4.0 Adobe programima
E _______________________
f 1998 Photoshop 5.0 History p_aleta 1 mc?%ucnost editiranja tipografskih elemenata, Save for

web opcija (u verziji Photoshop 5.5)

1999. Photoshop 6.0 Vektorski oblici, Liquify filter, Blending modes

2002. Photoshop 7.0 Novi engine za slikanje, Healing Brush, vektorizirani tekst
Q 2003. Photoshop CS Shaddow/Hightlight, Lens blur filter, Real-Time Histogram
|'|'| _______________________
>
=] Image Warp, Spot Healing Brush, Red-Eye alat, Lens Correction filter,
= 2005 Photoshop CS2 Vanishing Point, Smart Guides
w
2
= 2007. Photoshop CS3 Smart Filters, Quick Selection alat, Refine Edge alat
<
m
] Adjustments, Masks, pobolj§ano zumiranje i pomicanje, fluidno rotiranje
m 2008, Photoshop CS4 platna, Content Aware skaliranje



Trodimenzionalni kistovi i warping alati, Content-Aware Fill, Refine

2010 Photoshop CS5 Edge, Mixer Brush, Bristle Tips i Puppet Warp
Redizajn sucenlja s fokusom na pobolj$ani peformans, spremanje u
2012 Photoshop CS6 pozadini, Content-Aware Patch i Content-Aware Move
Smart Sharpen, Intelligent Upsampling, Perspective Warp, Linked Smart
Q 2013, Photoshop CC Objects i potpora za potrebe 3D printanja
m
A R
o i‘ 2014, Photoshop CC 2014 | Fokus maske, dva nova alata za blur
Nm | oo __
= O
m 5 2015. Photoshop CC 2015 | integracija Adobe Stock biblioteke
C
e

2017. Photoshop CC 2017 | novitemplate selector, podr§ka za SVG OpenType fontove

2.1.2. Podrudja primjene

Kao $to je spomenuto u poglavlju Adobe Photoshop, Photoshop nalazi svoju $iroku primjenu u

grafickom i1 web dizajnu, dizajnu web aplikacija te omogucuje rad s videom i animacijama te 3D

sadrzajem [6]. Na web site-u Adobe kao primarna podru¢ja Photoshop-ove primjene izdvaja

sliedeca:

FOTOGRAFIJA

Photoshop omogucéuje Siroki spektar alata pri editiranju fotografija — bilo da se radi o
bazi¢nim prepravcima kao §to je ispravljanje ekspozicije, prilagodavanje boje i svjetline,
rezanje i kadriranje ili onim kompleksnijim poput retusiranja slika, dodavanje zamucenja,
izoStravanja, spajanje vise razli¢itih fotografija i razli¢itih foto manipulacija koristeci

layer-e i blending mode-ove. [6]
DIZAJN

Photoshop takoder nailazi svoju primjenu u podru¢ju dizajna. Svojim alatima i
moguénostima pruza okruzenje pogodno za izradu grafickih rjeSenja za tisak, mobilne i
web aplikacije, kreiranju logotipa i rad s tipografijom, izradu slika, ilustracija i sli¢no.
Adobe CC omoguéava integraciju s Adobe Illustratorom te Adobe InDesignom' s ciljem

pruzanja kvalitetnijeg i opseznog dizajnerskog radnog tijeka. [6]

! Illustrator je alat tvrtke Adobe za izradu i obradu vektorske grafike, dok je InDesign alat namijenjen publikacijama



VIDEO

Svoju primjenu Photoshop, iako neSto Sturijih moguénosti, takoder nalazi i u video
editiranju. Koriste¢i jednostavan vremenski okvir, Photoshop omoguéuje rad s
pojedina¢nim video frame-ovima na princip jednak editiranju fotografija; poput retusiranja,

rezanja, izoStravanja slike, primjene filtara i drugih mogucnosti. [6]

2.1.3. Alati

Okosnicu svakog programa i rada u programu ¢ine njegovi alati. Jednako vrijedi i za Adobe
Photoshop, koji svojom Sirokom paletom alata i moguénosti, pruza zaista dobro korisni¢ko
iskustvo za rad u razli¢itim branSama i nailazi §iroku primjenu na brojnim podrué¢jima i zadacima
kao $to je spomenuto u prethodnom poglavlju, Podrucja primjene. Uz alate koje Photoshop
korisnicima stavlja na koriStenje tu je i §iroka paleta drugih izbornika poput Image, Layer, Type i
Select koji omoguéuju dodatne modifikacije i upravljanje dokumentom, izbornik filtera' te
otvaranje dodatnih!" prozora (panela) koji korisniku pruzaju jo§ §iri spektar moguénosti rada, a

moguce ih je otvoriti prema potrebi i karakteru rada. [10]

Alati unutar Photoshopa uobifajeno se u novim verzijama nalaze u izborniku lijevo nakon
pokretanja programa. Na svojoj sluzbenoj stranici, Adobe ih dijeli u sedam razli¢itih skupina.
Podijeljeni su prema namjeni i ¢ine ih: Selection tools, Navigation and measuring tools, Drawing
and type tools, Painting tools, Crop and slice tools, Retouching tools i 3D tools. [10] Alati koji
su navedeni azurirani su za trenutnu verziju Photoshopa CC. Ove skupine, njihove podskupine i

pojedinacni alatisu:

SELECTION TOOLS

Move tool omoguéuje pomicanje selekcija, layera i vodilica; Marquee tools stvaraju
pravokutne 1 elipti¢ne selekcije te selekcije pojedinacnih redova i kolona piksela (Cine ih
alati Ractangural Marquee, Eliptical Marquee, Single Coulumn Marquee , Single Row
Marquee), Lasso tools stvaraju prostorucne i poligonalne selekcije, odnosno selekcije

ravnim linijjama te omoguéuju magnetske selekcije koje program stvara putem

i Poput Liquify, Oil Paint, Lens Correction, Stylize, Noise, Blur, Distort, Sharpen idrugih

" Poput Actions, Adjustments, Brush, Character, Color, Histogram, Paragraph, Paths, History, Swatches, Timeline i
drugih



prepoznavanja karakteristika odredenog dokumenta poput boje i1 oblika (¢ine ih alati
Lasso, Polyigonal Lasso te Magnetic Lasso), Quick Selection omogucuje brzu selekciju
procesom nalik slikanju kistom s podesivom veli¢inom samog Kista te Magic Wand Kkoji

omogucuje selektiranje na temelju sli¢no obojenih podrucja. [10]

NAVIGATION AND MEASURING TOOLS

Navigation tools ¢ine alati Hand tool koji pomi¢e pogled na sliku unutar slikovnog
prostora, Rotate View tool koji rotira slikovni prostor, dokument bez utjecaja na njegove
pojedina¢ne elemente i Zoom tool koji povecava i smanjuje tocku gledista na slikovni

prostor, dokument. [10]

Measuring tools ¢ine alati Eyedropper tool koji uzima uzorak boje na slici, dokumentu,
Color Sampler tool koji prikazuje vrijednosti do Cetiri odabrane boje, Ruler tool koji mjeri
udaljenosti, lokacije i kutove odabranih to¢aka i Count tool koji broji objekte na slici,
dokumentu. [10]

DRAWING AND TYPE TOOLS

Path Selection tools selektiraju objekte i segmente pritom prikazujuci sidri$ne tocke i
smjerove linija i ¢ine ih alati Path Selection i Direct Selection; Type tools stvaraju
tekstualne objekte na slici, dokumentu i ¢ine ih alati Horizontal Type i Vertical Type; Type
Mask tools stvaraju selekcije u obliku tipografskih elemenata na slici, dokumentu i ¢ine ih
alati Horizontal Type Mask i Vertical Type Mask; Pen tools omogucuju stvaranje i
upravljanje putanjama zaobljenih rubova i ¢ine ih alati Pen, Freeform Pen, Add Anchor
Point, Delete Anchor Point, i Convert Point; Shape tools and Line tools omogucuju
stvaranje objekata odredenih oblika te linije kao normalan ili shape layer i ¢ine ih alati
Rectangle, Rounded Ractangle, Elipse, Polygon i Line; Custom Shape tool koji omogucuje

stvaranje proizvoljnih oblika. [10]

PAINTING TOOLS

Brush tool omogucuje slikanje nalik onom sa kistom, Pencil tool omogucuje slikanje
pravilnih linija, Color Replacement tool omogucuje promjenu odabrane boje u neku drugu
odabranu boju, Mixer Brush tool realistiéno simulira tehnike slikanja pomoc¢u oponasanja
viSestrukih nanosa boje na platno te varijabilne vlaZnosti i gusto¢e nanosa boje kistom,
History Brush tool kopira odabrano stanje iz pro§losti na trenutno stanje slike, dokumenta,
Art History Brush tool slika stiliziranim potezima koji simuliraju izgled poznatih slikarskih

tehnika, Gradient tool stvara pravocrtne, kruzne, kutne, reflektirane gradijente te gradijente
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u obliku dijamanta, Paint Bucket tool ispunjava sliéno obojena podru¢ja u bojom

izabranom kao foreground color. [10]

CROP AND SLICE TOOLS

The Crop tool reze sliku, dokument, the Slice tools stvaraju odreske (engl.slices) slike,
dokumenta (The Slice tool) te selektira odreske (The Slice Select tool). [10]

RETOUCHING TOOLS

Healing Brush tools uklanju crvenilo i neZzeljene znaajke (Spot Healing Brush tool) te
uzimaju zeljeni uzorak kako bi njime prepravio neZenjene znalajke i1 nesavrSenosti
(Healing Brush tool), Patch tool uklanja nesavrSenosti na zeljenom podrucju slike koristeci
odabrani uzorak (engl. pattern), Red Eye tool uklanja crveni odbljesak uzrokovan
bljeskalicom , Stamp tools uzimaju uzorak slike kojeg je potom moguce duplicirati na slici,
dokumentu (Clone Stamp tool) te omogucuyju stvaranje uzorka od zeljenog objekta (Pettern
Stamp tool), Eraser tools brisu, uklanjaju piksele i vracaju dijelove slike u njihovo ranije
spremljeno stanje (Eraser tool), pretvaraju Zzeljena podrucja u transparentna (Background
Eraser tool), te omoguéuje brisanje jednako obojenih podru¢ja samo jednim klikom
(Magic Eraser tool), Blur tool zamucuje (engl. blurs) dijelove slike, dokumenta, Sharpen
tool izostrava (engl.sharpens) dijelove slike, dokumenta, Smudge tool nrlja
(engl.smudges) dijelove slike, dokumenta, Dodge tool ¢ini odabrane dijelove slike,
dokumenta svjetlijima, Burn tool ¢ini odabrane dielove slike, dokumenta tamnijima,

Sponge tool mijenja zasi¢enost boje odabranih dijelova slike, dokumenta. [10]

2.2. llustracija

sllustracija je nezgodna rijec, ili je barem bilo tako do relativno nedavno®, piSe Lawrence
Zeegen u knjizi The Fundamentals of Illustration. ,Niti potpuno prihvaéena od strane
umjetnickih institucija niti od dizajnerske industrije, ilustracija se borila bez obzira na to.
Ismijavana kao neozbiljna od strane akademskih umjetnika i previse umjetnicka od strane
dizajnera, ilustracija se nasla u nicijoj zemlji izmedu dva podrucja“,objasnjava Zeegen. ,,Jasno je
da ilustracija lezi negdje izmedu umjetnosti i dizajna — no nikada se nije smatrala umjetnoscu,

niti joj je ikad dopusteno da postoji kao disciplina unutar dizajna“, nastavlja autor. [11]

U suvremeno doba, ilustraciju se susrece zapravo svugdje — na internetskim portalima,
druStvenim mrezama, blogovima, filmskoj i glazbenoj industriji, poslovnom svijetu i

promotivnom okruzenju — a one koje stoje na policama u tiskanim izdanjima, poput knjiga i
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Casopisa, svjedocCe vaznosti koju stavljamo, ali smo iranije stavljali na umjetnost i umjesnost ove
discipline. [11] ,Ilustracija igra veliku ulogu u danasnjem svijetu®, piSe Alan Male u knjizi
lllustration: A Theoretical & Contextual Perspective, ,,ona utjeCe na to kako smo informirani i
educirani o onome $to kupuyjemo, kako smo uvjereni da radimo stvari. Daje nam misljenje i

komentar. Daje nam kontekst i pri¢a nam price.* [12]

,,U najgorem slucaju, ilustracija je samo ne$to Sto izgleda dobro i ne daje nikakvo znanje i
informacije o onome S$to ilustrira. U najboljem sluCaju ilustracija potice gledatelja na
razmiSljanje, daje dodatno znaCenje tekstu, odnosno pruza bolje i dublje znacenje predmetu o
kojem govori,“ objasnjava Zeegen. ,,Vrijedne ilustracije su price i narative®, nastavlja, ,jone traze
od gledatelja da aktivno sudjeluje kako biu potpunosti shvatio neku poruku. (...) One susavrsen

spoj umjes$nosti, vjeStine ikreativnog razmi§ljanja.« [11]

2.2.1. Teorijske definicije

Bila ona u svojoj analognoj ili digitalnoj formi, ilustracija postoji ve¢ stoljeCima, ali kao
disciplina priznata je tek nedavno. [11] U Sjedinjenim Americkim Drzavama 1901. godine, kako
bi priznali vaznost ilustracije kao discipline, osnovano je udruzenje Society of Illustrators u New
Yorku s ciljem kako navode ,promovirati umjetnost ilustracije te vrednovati njenu povijest i
cijeniti njen razvoj i doprinose kroz izlozbe, predavanja i edukaciju, sve kako bi njeni ¢lanovi

bili ravnopravni u doprinosu drustvu u cjelini. [12]

Nacionalni muzej ilustracije SAD-a (sluzbeno The National Museum of Illustration in Rhode
Island, USA) pise kako ,,ilustratori kombiniraju osobno iskustvo sa slikovnom reprezentacijom
kako bi prenosili ideje. Vezuci se na misao americkog autora, kriticara i pisca Stevena Hellera
koji je slavno rekao kako je ,.ilustracija umjetnost malih ljudi“i, Nacionalni muzej ilustracije
dalie govori kako je ,ilustracija repozitorij naSe druStvene i kulturne povijesti te je stoga

znaCajna i trajna umjetnicka forma®, [11]

S druge strane, pisac i ilustrator Alan Male govori kako je ilustraciju najbolje opisati kroz
filozofsku implikaciju koja proizlazi iz ilustracije kao discipline — za razliku od likovne

umjetnosti, s kojom se ilustracija najces$ce poistovjecuje, ilustracija nije nuzno kultivirana radi

' Parafrazirano od »lllustration was the people's art
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sebe same i nije motivirana intrinzi¢nim uZicima koje pruza autorskom umu i emocijama koje bi
autor kao takav mogao dozivjeti. llustracija nije sama sebi svrha, ve¢ ona uvijek postoji da
opisuje neki kontekst nekoj publici. Dakle slika koja ne komunicira neku konteksualiziranu
poruku ne moZe se nazvati ilustracijom. Sirina primjene ove discipline, koju autor naziva
,uposlenom umjetnoééu“i, govori nam o velikom utjecaju ilustracije na naSu vizualnu kulturu i

vaznosti ilustracije kao suvremenog medija vizualne komunikacije. [12]

2.2.2. Digitalnailustracija

N1 jedan alat ili proces nije imao toliko utjecaja na podrucje ilustracije kao Sto to ima
raCunalo®, objasnjava Lawrence Zeegen u svojoj knjizi The Fundamentals of Illustration, ,...)
a ponovno rodenje i interes za podrucje ilustracije mogu se prepisati izravno ulozi koju je

odigralo upravo rac¢unalo.* [11]

Isprva domenom digitalnog stvaralastva ¢vrsto dominira graficki dizajn. Zeljni da istraze
podrucje digitalnog, graficki dizajneri okre¢u se raCunalima i ubrzo se stvara novi val,
neprekidno generiraju¢i nove graficke tehnologije. Macintosh izlazi 1984. godine i prvo je
osobno racunalo s grafickim suceljem — ¢ime, Zeegen tvrdi, pocinje digitalno doba grafickog
dizajna. U godinama koje su uslijedile, s padom cijene i hardware-a i software-a, raunala se
sve viSe koriste u privatne i poslovne svrhe, a obrazovati graficke dizajnere za rad u digitalnoj
sferi postaje 1 viSe no isplativo. Ilustracija ¢e, s druge strane, pricekati gotovo Citavo desetljece

da ude usvoju digitalnu eru. [11]

Bilo je potrebno dostatno vrijeme da se digitalni procesi u dizajnu adaptiraju te stvore nove
tehnologije koje ¢e ilustratorima omoguciti mjesto u domeni digitalnog. Kako su racunala
donaSala sve §iri spektar digitalnih mogucnosti i tehnologijom sada dostupnom ve¢em broju
ilustratora, procesi i primjena ilustracije dobiva novo svijetlo. Impresionirani sposobnosé¢u
koriStenja vjestina u crtanju i manipulaciji slika zajedno s lepezom drugih mogucnosti koje je
raCunalo otvorilo, ilustratori su u neprestanoj potrazi za novim nacinima izrazavanja,

prenasanja ideja i komuniciranja. [11]

Periodi¢no gledano, razvoj digitalne ilustracije moze se pratiti kroz tri perioda: 1990.-2000.

' Parafrazirano od ,,working art*
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godine, 2000.-2010. godine te 2010. godine- danas. [14][15][16][17]

Prvi period, od 1990. do 2000. godine, obiljezile su dvije struyje na podrucju ilustracije - prva se
odnosila na stvaranje starim tehnikama, dok je drugu oznacilo adaptiranje i eksperimentiranje
novim digitalnim medijima. Usprkos tome, ¢injenica je kako je rastuci broj ilustratora na ovaj
ili onaj nacin dolazio u doticaj s novom tehnologijom te sukladno adaptirao u vecoj ili manjoj
mjeri racunalo u svoj radni proces. Internet takoder donosi brojne promjene na podrucju
ilustracije, pruzajuci ilustratorima brojne prilike ali nose¢i i izazove. Na kraju milenija bilo je
jasno, da kulturno, kreativno i poslovno gledano, s prilagodbom i erom razvoja digitalnih alata,
ra¢unalo postaje dio Zivota, pa tako i onog ilustratorovog. U ovom se periodu naro€ito isticu
ilustratori poput Micka Wigginsa (Slika 2-1), Nany Stahl, Davea McKeana i Erica Dinyera.
[15]

Slika 2-1 llustracije za novine Micka Wigginsa, jedanog od pionira na podrucju digitalne ilustracije
ranih 90-ih

U prvom desetlje¢u 21. stoljeca ilustratori su ukljuceni u promjenjivu, opée povezanu globalnu
kulturu oblikovanu tehnologijom. Tlustracija se nastavlja primjenjivati u iskusanim podrucjima,
poput izdavastva, a kako se mnoge industrije adaptiraju digitalnom okruzenju — potraznja za
ilustracijom raste. NarocCit porast u prisutnosti ilustracije nalazimo u podrucjima poput filmske,
glazbene i televizijske industrije blisko povezanu uz animaciju i konceptnu ilustraciju. S druge
strane sve veci broj samoukih, ali i profesionalnih ilustratora, nalazi globalno online trziSte na
kojemu prodaju radove, preko vlastitih web stranica, drustvenih mreza ili specijaliziranih web
sajtova — ¢esto nazvana umjetno§¢u odmetnika (engl. outsider art). U ovom se periodu naro¢ito
istiCu ilustratori poput Jona Fostera (Slika 2-2), Marka Rydena, Fenga Zhua i Jamiea Hewletta.
[16]
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Slika 2-2 Iz serije ilustracija za HBO-ovu seriju ,, Leftovers “; ilustracijja: Jon Foster Cijije rad priznat na
brojnim podrucjima ukljucujuci i filmsku industriju

U drugom desetlje¢u 21. stolje¢a, od 2010. godine do danas, ilustracija reflektira svoj
cjelokupni napredak. Tako stara kao vjeStina, danas je definirana kroz medije i tehnologiju kroz
koju se stvara i dozivljava. Iako ilustratori slijede viSe-manje poznate obrasce ucenja zanata i
stiecanja vjesStina, putovi njihovog uspjeha viSe nisu ¢vrsto definirani — podrucje primjene
ilustracije toliko je Siroko da viSe ne postoje ustaljeni obrasci za stvaranje karijjere i stjecanje
prihoda. Komunikacija je lakSa 1 brza no ikada, ali odnos izmedu klijenta i ilustratora postaju
sve apstraktniji bez direktne komunikacije licem u lice. Ilustratori postaju sve vjestiji u online
promociji putem web stranica, druStvenih mreza, blogova i sli¢no te otkrivaju viSestruke alate 1
metode stvaranja reputacije kako bi svoj rad pokazali trziStu i svijetu. lako uloga ilustracije
ostaje ista, kako je svijet okrenut gotovo u potpunosti digitalnom dozivljavanju medija, ve¢ina
ilustratora u pravilu Koristi digitalne alate za stvaranje, promociju i stjecanje prihoda. U ovom
se periodu naro¢ito isti¢u ilustratori poput Yuko Shimizu (Slika 2-3), Tomera Hanukae, Jamesa

Jeana i Sama Webera. [17]

Slika 2-3.Ilustracije istaknute ilustratorice Yuko Shimizu,

2.2.3. Uloga, znanje i vjeStine ilustratora

, Uspjesni ilustratori moraju biti educirani, socijalno i kultumo svjesni komunikatori koji u radu

upotrebljavaju Siroki spektar intelektualnih i prakticnih vjestina “ — Alan Male [12]
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,,Uloga ilustratora prilicno je jednostavna — prenijeti poruku kroz sliku koriste¢i se umjetnos¢u
komuniciranja“, objasnjava Lawrence Zeegen u svojoj knjizi The Fundamentals of Illustration.
,Srz ilustriranja jest u promiSljanju — stvaranju ideja i koncepata koji ¢ine kraljeznicu onoga Sto
slika pokuSava komunicirati. Unijeti zivot i vizualnu formu nekom tekstu ili poruci jest primarna
uloga ilustratora - kroz sposobnost analitickog promiSljanja i razvijene prakti¢ne vjesStine,

ilustrator kreira sliku koja ima neSto za re¢i, koriste¢i kreativna nacine i sredstva kako to reéi.*

[11]

Kako bi ilustrator uspje$no ispunio svoju ulogu, koja zapravo lezi u poznavanju medijske
komunikacije, treba dakako posjedovati odredena znanja i vjeStine. ,,Mediji i materijali ko je
ilustrator uposlava u svrhu komuniciranja uvelike utjecu na Citanje poruke®, objasnjava Zeegen.
Dakle, znanja i1 vjeStine koje proizlaze iz poznavanja komunikacijske prirode kroz medij
vizualnog, Kljuéne su za uspjeSnost prenoSenja poruke. ,SavrSen sklad medija i koristenih
materijala zvuci kao cliché, ali mantra forma slijedi funkciju rezonira i danas®, podsjec¢a Zeegen.
[11]

Uz poznavanje medija bitno je poznavanje i posjedovanje vjeStina u podrucju umjetnosti i
dizajna, pisu D. Brazell i Jo Davis u knjizi Becoming a Successful Illustrator poput koristenja
boja, poznavanje kompozicijskih nacela, umijece crtanja i likovnosti, poznavanje materijala i
slicno. ,,Posjedovati dizajnerske vjesStine i senzibilitet je vitalno*, nadalje objaSnjavaju autori, ,,a
ste¢i vlastiti vizualni jezik i stil je samo vrh sante leda“.[13] Ne odmah ocite ilustratorske

vjestine stoga autori dijele na:

GENERICKE VJESTINE

GeneriCkim vjestinama smatraju se one koje su kljuéne za izradu ilustracija. Biti
kompetentan u koriStenju digitalnih tehnologija, u koriStenju specificnog vokabulara s
podrucja umjetnosti i dizajna te opCenite vjeStine upravljanja slikama koriste¢i digitalne
alate 1 programe, samo su neke od vjestina koje se smatraju standardom na podrucju
ilustracije. Nadalje, ilustratori cesto stvaraju slike za primjenu u kompleksnijim
multimedijskim okruZenjima, na primjer u okolini gdje se koristi tipografija i drugi
elementi grafickog konteksta, tako da je ilustratoru esencijalno da poznaje i ta podrudja.
Pozeljno je takoder primjena znanja 1 vjeStina iz podrucja opée vizualne pismenosti i

osjecaj za opée vizualno razlucivanje. [13]

PRENOSIVE VJESTINE

Prenosivim se vjeStinama (eng. transferable skills) smatraju one koje sluze ilustratoru kao

16



dodatan alat kako bi se efektivno snalazio u Sirem spektru podrucja i izazovima koje ova
profesija nosi — u domeni profesionalnog svijeta industrije, socijalnog okruzenja te
financijske stabilnosti. Ove vjestine uglavnom podrazumijevaju organiziranje vremena i
resursa, pronalaske poslovnih prilika i komunikaciju s klijentima u pisanom i govornom

obliku, samopouzdanje u vlastito znanje, poznavanje autorskih prava i slicno. [13]

POSLOVNE VJESTINE

Poslovne vjestine omogucavaju pretvaranje strasti prema ilustraciji u uslugu koju ilustrator
nudi u zamjenu za financijsku sigurnost, naroCito na dugoro¢noj razini. One sluze
razumijevanju aspekta poslovanja, ukljuCuju¢i financijsko planiranje, oblike ugovora I
ugovornih obaveza, autorskih prava i licenci, poreznih obveza, raunovodstvenih aspekta i

sli¢no. [13]

,»Razvoj osobnog vizualnog jezika, razumijevanje materijala i materije te trendova industrije,
samo je jedan dio cijele price (...) biti ilustrator prije svega zahtjeva predanost, osobnost i
talent®, objasnjava Lawrence Zeegen -,,malo je vjerojatno da ¢e ilustrator koji manjka na nekom

od ovih podrucja uspjetirazviti uspjeSnu i dugoro¢nu karijeru®. [11]

2.2.4. Podrucja primjene ilustracije

Vizualno opisne slike su svuda oko nas 1 njihova se primjena, iako joS§ uvijek zastupljena, pocela
kretati iz o¢itih i isprobanih podrucja primjene, kao $to je to izdavastvo, na manje o¢ita podrucja
kao Sto su oglasavanje i dizajn proizvoda. ,,Novo trziSte je zaista veliko, ono cvijeta 1 gladuje za
novim talentima* prenosi ilustrator Daniel Hsieh. U knjizi Becoming a Successful Illustrator
Darek Brazell i Jo Davies govore kako u dana$njem svijetu s rastu¢om zeljom za slikama,
vjesStine ilustratora se mogu regrutirati u bezbroj svrha, a digitalno trziSte premosSc¢uje jezicne,
vremenske i prostorne barijere. [13] Iako je ilustraciju moguce primijeniti u brojnim podruéjima

kao kljuCna stara, ali i nova trzista Brazell 1 Davies isticu:

NOVINARSTVO

llustracija u novinarskim izdanjima ima dugogodi$nju tradiciju, i iako industrija trenutno
prozivljava krizu zbog rasta digitalnih portala, vjestine i rad ilustratora i1 dalje su prijeko

potrebna u podruc¢jima kao $to su to izdanja na lokalnoj, nacionalnoj ili regionalnoj razini
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i raznim specijaliziranim izdanjima'. No primjenu ilustracije takoder moZemo na¢i na
digitalnim platformama i digitalnim portalima. [13] Slika 2-4

RACZKUJACY KONSUMENCI

SWIAT DZIECI
W PERSPEKTYWIE

KULTURY
K==

Slika 2-4.,, Raczkujgcy konsumenci. Swiat dzieci w perspektywie kultury" (Zutok ljunci potrosadi.
Svijet djece iz perspektive kulture), Kontast, veljaca 2015., ilustracija: Damian Didenko

lustracije u novinama uglavnom opisuju neki novinarski tekst ili pri¢u, a variraju od
naprosto dekorativnih ilustracija do onih baziranih na odredenom tekstu predstavljenom u
novinarskom izdanju. Takoder, nailazimo i ilustracije razliCitih veli¢ina — od manjih
slikovnih prikaza pa sve do ilustracija na dvije stranice. Nesto rjede, ilustracije se nadu na
naslovnicama magazina, §to na primjer Cesto ¢ini The New Yorker. Nadalje, teme
novinarskih ilustracija su razli¢ite a mogu pokrivati Siroki spektar tema kao §to su

politika, financije, Zivotni stil, putovanja, zdravstvo, tehnologija i druge. [13]

IZDAVASTVO

lustracija svoju primjenu nalazi u izdavastvu bilo da se radi o tiskanim ili digitalnim
izdanjima, naroCito knjiga i to u Cetiri velika podru¢ja — beletristika, publicistika, knjige
namijenjene djeci/slikovnice te graficke novele (engl. graphic novels) i stripovi.
llustracije se primjenjuju i kao naslovnice i kao dodatne ilustracije unutar knjige a
variraju u koli€¢ini po publikaciji i veli¢ini (od manjih prikaza pa sve do ilustracija koje

ispunjuju cijelu stranicu). [13]

Knjige za djecu/slikovnice i graficke novele, odnosno stripovi, obicno sadrzavaju najvise
ilustracija te najceS¢e dolaze ispisane u boji. Kod ilustracija za ovaj tip publikacija bitno
je fokusirati se na dob ciljanih ¢itaca te njima prilagoditi slikovni sadrzaj. Ova dva tipa
nerijetko dolaze u potpunom autorstvu ilustratora, ukljuCujuéi tekstualne dijelove. [13]
Slika 2-5

Sto s tide beletristike i publicistike, ovdje ilustracije susreéemo nesto rjede, no ne izostaju

iy . .. y L y . L . Sy
casopisi o putovanjima, Casopisi za zene, Casopisi za vrtlarenju, ¢asopisio hrani i sli¢no,
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— ovdje se naj¢esce radio ilustraciji naslovnica te manjim popratnim ilustracijama. [13]

Slika 2-5 llustracije za knjigu Marie Parr "Wafer heart"; ilustracija: Dina Zhuravleva

DIZAIN | OGLASAVANJE

U ovoj bransi izmedu ilustratora i klijenta nalazi se posrednik, obicno agencija, koja
komunicira s ilustratorom kako bi ispunio Zelje i potrebe klijenta. Klijenti variraju od
ve¢ih multinacionalnih kompanija do manjih lokalnih tvrtki te nerijetko traze niz
ilustriranih sadrzaja, poput broSura, vizuala za web, postera, kalendara, promotivnih 1
sli¢nih popratnih materijala. [13] Agencije takoder Cesto traze izradu razli¢itih ilustracija
za pakiranja proizvoda, od igracaka za djecu, kozmetickih, prehrambenih i sli¢nih
proizvoda [13] Slika 2-6

Slika 2-6 Pakiranje za FongCha ¢aj; ilustracija:Nio Ni

Takoder, ovdje je bitno spomenuti ucestalost primjene ilustracije u glazbenoj industriji,
koja se uglavnom Koristi kao naslovnica glazbenog albuma, u dizajnu popratnih

proizvoda poput majica i bedZeva, postera za dogadanja i koncerte itd. [13] Slika 2-7
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Slika 2-7 Poster te poprami promotivni i informaticni sadrzaji za ,, Afro Fusion Festival*“; dizajn i
ilustracija: Cynthia Alonso
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ILUSTRACIJA KONCEPATA

Kod ilustracije koncepta mozemo govoriti o dvije velike grane — ilustraciji koncepata za

film te ilustraciji koncepata za igre. [13]

Ilustracije koncepata za film izraduju specijalizirani umjetnici i to u najranijim fazama
razvoja filma. Tlustratori uglavnom rade u timovima sa stru¢njacima iz drugih podrucja i
to sve pod vodstvom producenta. Na ovom podrucju radi nesto manje ilustratora zbog
specificnih zahtjeva industrije 1 Cesto su izrazito specijalizirani za odredeno podrucje pri

¢emu najcesce govorimo o osmiSljavanju nestvarnih likova, lokacija i scena. [13]

Slika 2-8 Koncept likova za video igru “Almost Hero “ Bee Square Games stuija, ilustracija: Pablo
Hernandez

llustracije koncepata za igre uglavnom se odnose na kreiranje vizualnih elemenata ili u
nekim slucajevima i cijelog korisni¢kog sucelja igre. Ovdje mozemo govoriti, kao 1 kod
filma, o kreiranju likova scena i lokacija te ilustraciji koja pomaze vizualizaciji i pred-

produkcijskoj fazi razvoja igre. [13] Slika 2-8

DEKORATIVNA ILUSTRACIJA

Dekorativna se ilustracija uglavnom koristi kao sastavni dio proizvoda, odnosno, krasi
odjevne predmete, zidne tapete, maske za tablet i mobilne uredaje, komade namjestaja i

slicne dekorativne proizvode. U ovoj bransi Cesto sre¢emo kreiranje ilustriranih uzoraka

ili primjenu ilustracija na ogranicenom broju proizvoda. [13] Slika 2-9
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Slika 2-9,, Lishoa “zidna tapeta, ilustracija: Aitch
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AUTORSKA ILUSTRACIJA

Autorska se ilustracija, kao §to samo ime i govori, odnosi na ilustraciju kreiranu iz puke
autorske kreativnosti i Zelje za stvaranjem te nema direktnu komercijalnu vrijednost.
Odnosi se na samo- inicijalizirane projekte koji sluze vlastitom ucenju i razvoju, a nerijetko
posluze kao promotivni materijali za rad samog ilustratora — knjige skica, knjige radova,

eksperimentalni radovi, rukotvorine i sli¢no. [13]

2.3. Primjena Photoshopa u ilustraciji

Kako bi se izradila digitalna ilustracija, potrebne su dvije stvari — racunalo s instaliranim
posebnim software-om te alat za crtanje. ,,U principu, digitalnu ilustraciju moguce je izraditi u
Microsoft Paint-u pomo¢u misa, no to je daleko od idealnog®, pise Monika Zagrobelna u ¢lanku
Digital Drawing for Beginners: An Introduction to the Tools.[18] Danas postoji mnogo
programa koji su viSe ili manje specificno namijenjeni izradi digitalne ilustracije, medu kojima
se kao dominantan isti¢e Photoshop, dok su mu prihvatljive alternative GIMP, Corel Painter 1

Krita [18][19].

Adobe Photoshop daleko je najpopularnije ime u svijetu digitalne ilustracije, standard je
industrije i koriSten je od strane vecine digitalnih ilustratora - iako program kao takav nije
namijenjen u ovu svrhu i sam ilustrator vjerojatno ne¢e u svom radu koristiti ve¢inu funkcija
koje mu Photoshop pruza. [18][20] O ucestalosti koriStenja Photoshopa u svrhe izrade digitalne
ilustracije te o Sirini njegove primjene u razli¢itim projektima koje uposljavaju digitalnu
ilustraciju govori nam najpopularnija online portoflio platforma Behance. Behance je zajednica
profesionalaca i amatera razli¢itih kreativnih bransi, te sadrzi zaista pozamasnu bazu digitalnih
ilustracija u kojima se kao najces$¢e koriSten alat u izradi isti¢u upravo Adobe-0vi programi
Photoshop i llustrator.[20] 2012. godine Adobe otkupljuje platformu ¢ime spaja dva svijeta —

onog izrade i onog promocije digitalnih vizualnih sadrzaja. [21]

2.3.1. Primarni alati

Kada govorimo o primarnim Photoshop-ovim alatima za izradu digitalne ilustracije isticu se
posebno dva alata a to su Brush i Eraser, posto isti djeluju kao kist i gumica $to u najbolju ruku
simulira procese analogne izrade ilustracija. Alati su u srzi razli¢iti, posto jedan stvara piksele
dok ih drugi brise, no postavke koje mozemo podesiti na oba su slicne — oblik kista, veli¢inu

kista, vidljivost (engl. opacity) i tok (engl. flow). Nadalje kod izrade ilustracije Cesto se koriste i
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Blur, Sharpen, Smudge, Paint Bucket i Gradient te Burn, Sponge i Dodge alati, ¢ije su
funkcionalnosti objasnjene u poglavlju 2.1.3 Alati.

S druge strane, kada govorimo o primarnim Photoshop-ovim funkcijama i opcijama za
upravljanje i obradu digitalne ilustracije, to su u pravilu oni koje Photoshop otvara kada se radni
prostor u izborniku ,,Workspace* na ,Painting”. Ovdje stoje paleta Layers, koji omogucava
razlaganje elemenata na zasebne slojeve, paleta History koja omogucava vracanje na odredeno
stanje u povijesti, paleta Adjustments koja omogucava razli¢ite oblike podesavanja poput boje,
svjetline, kontrasta i slicno te Properties koja omogucava dodatne opcije i regulaciju
podesavanja iz palete Adjustments. Potom slijede Color, Brush i Brush Presets koji se odnose na
dodatna podesavanja preferencija vezanih uz kistove (poput dodavanja teksture, dodavanja boje,
definiranja kuta kista) i boje. Posljednja dolazi paleta Navigator koja nam omogucuje lakSu

navigaciju platnom.

2.3.2. Grafic¢ki tableti

Graficki tableti sluze kao alternativa klasi¢nom ra¢unalnom input-u, odnosno tipkovnici i miSu.
Tipkovnicom je 1 miSem, barem Sto se izrade digitalne ilustracije tiCe, zamjetno teze postici
zeljenu kvalitetu ilustracije - jednostavno receno, miSem i tipkovnicom je tesko replicirati
pokrete 1 radnje koje se postizu prilikom izrade ilustracije analogno. Graficki tableti stoga
postaju popularna alternativa na podru¢ju digitalne manipulacije slikom, grafickog dizajna, video
obrade i animacije, a naroc¢ito izrade digitalne ilustracije, gdje je oponasSanje pokreta rukom,

kljuno za izvedbu ikvalitetu krajnjeg output-a. [23]

Kako bi kreator prenio svoje vjeStine u digitalno okruzenje, naroCito ako se time bavi
profesionalno, preporuca se koristenje specijalno dizajniranih grafickih tableta nasuprot onima
dostupnima na Sirem masovnom trziStu. Kada se govori o grafickim tabletima za ovu namjenu,
moze se govoriti o opéenito dva tipa — graficki tableti koji, ponaSaju¢i se kao monitor, korisniku
dozvoljavaju da svoj rad vidi direktno na samom tabletu te graficki tableti koji djeluju kao
zaseban input uredaj i pretvaraju pokrete u digitalne signale vidljive na postoje¢em monitoru.
[24] Osim ove podijele, na trziStu specijaliziranih grafickih tableta nalaze se razlike i u njihovim
specifikacijama koje naj¢e$¢e ukljuCuju razlike u veliCini aktivnog podrucja, osjetljivosti na
pritisak (engl. pressure sensitivity), definiranju kontrolnih tipki te upotrebiprograma za rad. [23]
Graficki tableti u pravilu dolaze sa posebnom olovkom (engl. pen/stylus) koje, uz to S§to
pridonose prirodnosti linija, omoguéuju bolje simuliranje analognih tehnika tako S§to u

kombinaciji s tabletom stvaraju okruZenje osjetljivosti na pritisak same olovke. [23][24]
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Cwrsto pozicionirana kao standard industrije grafi¢kih tableta nalazi se tvrtka Wacom. Osnovana
je 1983. godine u Japanu te se odmah na trzistu pozicionira kao vode¢i proizvoda¢ grafickih
tableta i olovaka, gdje ostaje do danas zahvaljuju¢i upotrebi posebne patentirane
elektromagnetske tehnologije. [25] Wacom-ovo godiSnje izvjesce iz 2016. godine govori kako

Wacom uzima veliki dio trzi$ne torte od ¢ak 88% posto udjela. [26]

Medu ostalim popularnijim proizvoda¢ima grafickih tableta su Ugee, Huion i Yiynova te ih je
moguée nabaviti po znatno prihvatljivijoj cijeni od Wacom-ovih. Ove tvrtke proizvode
prihvatljive alternative Wacom-ovim tabletima, te su dobar uvod u svijet digitalnih tableta
naro¢ito pocetnicima te amaterima i onima koji su skloniji nov¢ano prihvatljivijim uredajima.

[24]
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3. Prakti¢ni dio

Prakti¢ni dio rada odnosi se na proces izrade digitalnih ilustracija za zbirku pjesama ,,Budi mi
prijatelj* autorice Karoline Perec pomocu programa Adobe Photoshop. Ovo ¢ée poglavlje dati
presjek cjelokupnog tijeka rada pri izradi ilustracija - isprva ¢e se ukratko predstaviti zbirku
pjesama i autoricu, potom ¢e definirati ciljeve rada, opisati metode izrade ikoriStene alate kako

bi naposljetku opisao samu tehnologiju izrade ilustracija kroz tehnicke aspekte rada u programu.

3.1. O zbirci pjesama

Zbirka pjesama ,,Budi mi prijatelj* autorice Karoline Perec izdana je 2011. godine u Varazdinu u
pet tisuca primjeraka. Zbirka se sastoji od 104 pjesama, podijeljenih u pet tematskih cjelina —
,Budi mi prijatelj* sadrzi pjesme drustvene tematike u kojima autorica uglavnom govori o
obitelji, prijateljima i socijalnim odnosima reflektiraju¢i svoje emocije i razmisljanja, ,Dobri
pastir* sadrzi pjesme religiozne tematike, ,Moja Domovina“ sadrzi pjesme nadahnute ljubavlju,
fascinacijom i odanosti domovini, ,Susret” s nesto intimnijim pjesmama baziranim na ljubavi
izmedu muskarca i Zene te autori¢inim doZivljajima ljubavi opéenito i ,,Zivot®, posljednja
tematska cjelina koja sadrzi pjesme inspirirane svakodnevnim stvarima i detaljima koje autorica

zamjecuje u vlastitoj okolini.
Iz dijela u zbirci pjesama ,,0 autoru‘:

Karolina Perec rodena je 17. kolovoza 1979. g. u Varazdinu. U osmoj godini Zivota
dijagnosticiran joj je tumor na mozgu u predjelu ocnog zivca. Dvije teSke operacije i
zracenje uzrok su potpunog gubitka vida i 80% ostecenog sluha. Ipak, uz potporu
obitelji i samostalnog rada zavrsila je osnovnu i srednju skolu u Centru za slijepe
, Vinko Bek* u Zagrebu — smjer administrator. Njezine zdravstveme poteskoce
prepreka su dalinjem Skolovanju i mogucnosti njenog zaposljavanja. Zivi mirnim i
povucenim zivotom kojeg dijeli s majkom, bratom i sestrom u mirnoj varazdinskoj

Cetvrti (...)

Posebno mjesto u njenom stvaralastvu zauzima pisanje pjesama, cime se pocela
baviti 2000. godine. Pjesme stavnja u ,, brajicu”, a potom uz suradnju i pomoc

gospode Larise Bodlaj pjesme su napisane abecedom. (...)
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Knjiga pjesama mala je nagrada Karolini za osebujan rad u ovakvim Zivotnim
okolnostima, ali njezina vedrina i optimizam moci ¢e se citati u gotovo svakoj pjesmi,

Jjer Citajuci ih cujemo Karolinin poziv: budi mi prijatelj ...[ 28]

3.2. Ciljevi rada

Cilj rada jest izrada popratnih ilustracija za pjesme iz zbirke te naposljetku i omota same zbirke.
Odabrano je Sest pjesama razli¢itog tona i kompozicije: ,,Prijatelj*, ,Moja Mama®, ,Sretan Put®,
,Uspomena“, ,Moje Selo Malo* i ,Cekanje®. Pjesma ,Prijatelj* Karolinin je osvrt na odnos s
psom kojeg smatra velikim prijateljem, ali i kolegom koji joj, zbog njene sljepoce, svakodnevno
pomaze u dnevnim aktivnostima. ,,Moja Mama“ je pjesma u kojoj Karolina iznosi emocije koje
proizlaze iz njenog odnosa sa majkom i svojevrsna je zahvala majci za sve joj dano. Pjesma
Sretan put® upucena je poruka bezlicnom putniku kroz staze Zivota. ,,Uspomena® je pjesma koja
opisuje dozivljaj odlaska nama dragih ljudi i osvrée se na vrednovanje sjecanja kao jedinog Sto
nam nakon odlaska ostaje. ,,Moje Selo Malo* pjesma je narativne tematike u kojoj autorica
prenosi zamijeéeno iz seoske okoline. ,Cekanje* je pjesma u kojoj Karolina na intiman naéin
govori o nesretnom ljubavnom iskustvu te ¢eznji i nadanju koja je iz njega proizasla. Prilog 1 —

Odabrane pjesme sadrzi puni tekst svih odabranih pjesama.

Odabrane pjesme, ukljuujuci cijelu zbirku svojevrsna su refleksija Karolinina zivota, u ¢ijim
stihovima se o€itava autoricin odnos s ljudima, Zivotinjama, prirodom i okruzenjem te Bogom.
Kao $to je objasnjeno u poglavlju llustracija, cilj ilustracije jest kroz slikovni prikaz prenijeti
neku kontekstualiziranu poruku. Kako je tematika odabranih pjesama i cijele zbirke u pravilu
vezana uz ljude iprirodu, upravo ¢e ti motivi biti prikazani i samim ilustracijama, uz prenosenje

tona pjesme putem kompozicije, odabira motiva isli¢no.

lustracije je potrebno izraditi u kromatskom i akromatskom sustavu boja u A5 formatu, posto ¢e
Zbirka svoje izdanje na¢i i u elektroni¢kom i u tiskanom izdanju. Ilustracije u boji biti ¢e dio
elektronickog izdanja, dok ¢e akromatske svoje mjesto, prvenstveno zbog financijske ustede

prilikom izdavanja, naé¢i u tiskanom izdanju. Omot ¢e u oba slucaja biti izdan u boji.

3.3. Metode i alati

Prakti¢ni dio zadatka odraden je u programu Adobe Photoshop, to¢nije verziji Adobe Photoshop
CS6. Isprva su izradene sve ilustracije pjesama, a potom omot knjige kako bi on predstavljao

stilski i konceptualni odraz svih zavrsenih ilustracija. Prije poCetka rada u Photoshopu, bilo je
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potrebno provesti vrijeme Citajuci pjesme i iS¢itavajuci znacenja i motive u samim stihovima te
skiciranju koncepata analogno na papiru, no ve¢i dio rada svakako se odnosio na kasniju fazu
izrade ilustracija u samom programu. Sve ilustracije pjesama su izradenec prema unaprijed
definiranim koracima koje ¢e u detalje biti opisane u poglavlju lzrada ilustracija, a u srzi se
sastoje od skiciranja i razvoja koncepta, obrade ilustracije bojom i teksturom, te finaliziranja
ilustracije. Sto se tice vremenskog trajanja projekta, pretpostavka je kako ¢e izrada trajati
otprilike dva tjedna.

Tehnologija izrade ilustracija je digitalna te ukljucuje tri kKomponente- stolno ra¢unalo Windows
10 Pro operativnog sustava, graficki tablet Ugee 1910B te program za obradu (Photoshop CS6).
Graficki tablet, jedna je od klju¢nih komponenti za izradu ilustracija zbog svoje mogucnosti da
pri izradi digitalne ilustracije, oponaSajuci pokret rukom, prenosi analogne signale u digitalne,
Sto je kljutno za izvedbu i kvalitetu krajnjeg output-a, kako je objasnjeno u poglavlju Graficki
tableti. Ugee 1910B je graficki tablet koji se pri spajanju na racunalo ponasa kao monitor,
odnosno na njemu je vidljiva slika, a cijela povr§ina monitora je aktivno podrucje, ¢ime se
donekle replicira inace analogan rad. Tablet dolazi sa stylus-om, svojevrsnom olovkom, koja ¢e
se u kontaktu s aktivnom povrSinom ponasati kao bilo koji odabrani alat unutar Photoshopa.
Olovka ima dvije dodane tipke, kako bi unaprijedila svoju funkcionalnost, a korisnik njihove
naredbe moze podesiti prema vlastitim potrebama — prva je podeSena kao alat Brush, te druga
kao alat Eraser. Ova ¢e funkcionalnost olovke imati znac¢ajnu ulogu pri izradi jer omogucuje
mnogo brzu izmjenu dva alata koji ¢e najéeScée biti koristeni prilikom izrade ilustracija. Nadalje,

Tablica 2 sadrzi popis svih alata i funkcija programa koji su koristeni prilikom izrade.

Tablica 2. Koristeni alati i funkcija programa Adobe Photoshop CS6 prilikom izrade prakticnog zadatka

TIPKOVNICKI
IME ) FUNKCIIA
PRECAC
Move \Y Pomicanje selekcija, layer-a i vodilica
Lasso L Stvaranje prostoruénih selekcija
Magic Wand w Selektiran je na temelju sli€no obojenih podrucja
> Eyedropper | Alt Uzimanje uzoraka boje
E _________________________
- Brush B Kist
Eraser E Gumica
Paint Bucket G Ispunjavanje podru¢ja bojom izabranom kao foreground color.
Hand H Pomicanje tocke gledista na sliku unutar slikovnog prostora
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» Smart Sharpen

Rotate View R Rotiranje slikovnog prostora bez utjecaja na pojedinaéne elemente
Z|Alt+
Zoom Mouse Povecava/smanjuje to¢ku gledista na slikovni prostor
Scroll
Omogucuje upravljanje layer-ima, dodavanje novih layer-a, brisanje
Layers F7 layer-a, upravljanje vidljivo§¢u i Blending mode-ovima layer-a i
slicno
History % Omogucuje vrac¢anje na stanje u povijesti do definiranog broja stanja,
spremanje toc¢ke u povijesti
Omogucuje dodavanje layer-a za razlicitih vrsta prilagodbe slike,
Adjustments X mogu¢ odabir izmedu 16 vrsti prilagodbi (Vibrance, Levels, Color
l®) Balance, Exposure isli¢no)
=
o
% Properties X Dijalog za upravljanje odabranomvrstom adjustment layer-a
m _________________________
(@]
5 Color F6 Sluzi za definiranje boja i odabir sustava boja
o RN )
Omogucéuje upravljanje odabranim kistovima, njihovom veli¢inom,
Brush F5 .l e s by e
dinamikom, teksturom, vidljivo§¢u, naéinom kontrole unosa i sliéno
Omoguduje odabir zadanih kistova, upravljanje veli¢inom kista,
Brush Presets X stvaranje novih kistova,brisanje kistova, u¢itavanje kistova iz
datoteka isliéno
Navigator X Shuzi z yla‘lstoruc'no’pomvlcanje na_lvzeljenu_tocku glediSta na sliku te
povecanje i smanjen je tocke glediSta na sliku
Save Ctrl+S Sprema doku ment
Save As Shift+Ctrl+S | Odabire na¢in spremanja dokumenta
Place X Umeée datoteku u dokument
Undo Ctri+z Vraca na prethodno stanje
Free Transform Ctri+T Mijenja veliCinu, rotira sadrzaj odabranog/odabranih layer-a
Layer » New Sh'ﬂT\IC”H Stvara novi layer
-n
% _________________________
Layer » Duplicate
5 Y P X Duplicira layer ili vise njih
S Layer
Layer » Crate L
A +Ctrl+
Clipping Mask Alt+Ctrl+G | Stvara clipping masku
Layer » Rasterize X e L
» Smart Object Pretvara ,pametni objekt* u rasterski prikaz
Layer » Merge Ctr+E | Spajaodabrane | jedinstveni |
r ran I- n n r
Layers paja odabrane layer-e u jedinstveni laye
Filter » Sharpen .. . .
P X Otvara dijaloski okvir s postavkama za Smart Sharpen
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Tocku glediSta na sliku postavlja na gledi$te koje odgovora stvarnoj

. ri+1 e .
Pixels ct veli¢ini postavljenog dokumenta
View » Fit on Ctrl+0 Tocku glediSta na sliku postavlja na glediSte koje odgovora veli¢ini
screen okna programa

3.4. lzrada ilustracija

Poglavlje lzrada ilustracija opisati ¢e proces nastanka ilustracija, odnosno tehnicki aspekt
njihovog nastanka kroz opis rada te koriStenje alata i funkcija programa Adobe Photoshop CS6.
Proces je podijeljen u nekoliko koraka, a oni ukljuéuju: 1) Postavljanje dokumenta, upravljanje
layer-ima, odabir palete boja i kistova; 2) Skiciranje, izrada vanjskih linija; 3) Dodavanje boje,
tekstura i sjena; 4) Dodatna podesavanja i izvoz ilustracija. Naposljetku ¢e, u posljednjem dijelu

poglavlja, biti opisan proces nastanka ilustracija za omot zbirke pjesama.

3.4.1. Postavljanje dokumenta, upravljanje layer-ima, odabir palete boja i

kistova

Nakon otvaranja Adobe Photoshop C6, kliknuvsi na File » New otvorilo se okno sa postavkama
za otvaranje novog dokumenta. Za svih su Sest ilustracija odabrane iste postavke, odnosno
velicina platna (Size) je postavljena na A5 format, rezolucija (Resoulution) podesena na 300
piksela po in¢u te kao sustav boja (Color Mode) zadan je RGB sustav, posto ¢e prvo biti izradene
ilustracije za potrebe prikazivanja na ekranu, odnosno za elektronicko izdanje zbirke pjesama.
Jedino sto je pri postavljanju pojedinog dokumenta promijenjeno jest ime (Name) dokumenta
koje je odabrano sukladno naslovu same pjesme koja ¢e biti ilustrirana. Slika 3-1 prikazuje

postavke koje su podeSene za svih Sest novootvorenih dokumenata.

New hed
Name: | priatef] | oK ]
Preset: | International Paper V| Cancel
Size: | AS ~] Save Preset...
width: [ 148 |[ milimeters ~|| | Delete Preset
Height:| 210 || Milimeters V|
Resolution: | 300 || Pixels/Inch v|
Color Moce: [ RGB Color | [ & bit v
Background Contents:| Whice V| i F
¥ Advanced 12,4M

Slika 3-1 Postavke dokumenta
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U koraku postavljanja radnog prostora, otvoreni su svi prozori koji ¢e biti koriSteni prilikom
izrade ilustracija. Photoshop CS6, uz standardnu traku alata pozicioniranu krajnje lijevo unutar
okna programa, nudi mogucnost postavljanja desne trake, koju je lako prilagoditi potrebama
korisnika, ¢ime se postize sistemati¢nost te brzi pristup Zeljenim funkcijama 1 moguénostima
programa. Kada korisnik klikne na Window na traci izbornika, otvara se padaju¢i izbornik koji
sadrzi sva dodatna okna koja je moguce otvoriti, te potom, prema zelji, pozicionirati u desnu
traku unutar okna programa. Za potrebe rada pri izradi ilustracija otvorena su sliedeca okna:
Layers, History, Adjustment, Properties, Color, Brush, Brush Presets te Navigator. Kako bi okna
bila pozicionirana na desnu traku jednostavno su miSem odvuéena na Zeljenu poziciju unutar
trake, gdje sada ostaju fiksni prilikom rada, a moguce ih je klikom otvoriti kada se za to ukaze
potreba. Ovako specifi¢no organiziran radni prostor (engl. workspace) Photoshop pamti te ¢e isti

biti koriSten tijekom cijelog procesa izrade ilustracija.

Nadalje, kako bi rad i radni tijek bio bolje organiziran, u svih je Sest dokumenata izradena ista
sistematizacija i hijerarhija layer-a uoknu Layers. Klikom na ikonu za stvaranje novih layer-a u
oknu Layers, stvoren je layer ,skica“ na kojem ¢e biti izradena skica ilustracije, a potom je
pomoc¢u ikone za stvaranje grupe layer-a stvorena grupa nazvana ,.ilustracija®. U grupi layer-a
Hlustracija® stvoreno je tri nova layer-a — ,vanjske linije gdje ¢e se nalaziti vanjske linije
ilustracije (engl.linework), ,boja“ na kojem ¢e se nalaziti svo obojenje i ,dodaci” na kojem ¢e
biti izradeni dodatni elementi ukoliko ¢e za to postojati potreba. Layer-u ,ilustracija* dodane su
dvije maske (Clipping Mask) pomocu precaca Ctrl+Alt+G, ali isto je moguce uCiniti klikom na
Layer » Create Clipping Mask, sto omogucuje crtanje i dodavanje elemenata ograni¢enih na
podrucje layer-a kojem radi masku, u ovom slu¢aju layer-a ,boja*. Prvi od tih dvaju layer-a je
,detalji“ na kojem ¢e ilustraciji biti dodavani detalji, uzorci i teksture, a drugi ,,sjena“ na kojem

¢e ilustraciji biti dodane sjene na odgovarajuca podrucja. (Slika 3-2, desni prikaz)

PRIMARNE  BOTE
"
. b - SEKUNDARNE
‘ BOJE (ZELENG)
—TERUIARNE
- BOIE (PLAVEY)
KISTOVI 7,

HARD ROUND
w @ & CHARUYAL
STIPPLE

) ¢ -SKIn” poje

Slika 3-2 Postavljanje layera, odabir palete boja i kistova
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Pojedini autori obicavaju prije samog rada odabrati ograniceni spektar boja te kistove kojima ¢e
se koristiti pri izradi. Na zasebnom layer-u izraden je spektar boja kojim primarno dominiraju
topli tonovi (crvena, narancasta, roza), a sekundaran 1 tercijaran skup ¢ine zelene, odnosno plave
nijanse te tzv. ,skin boje* koje ¢e biti koriStene, kao Sto rijec¢ i govori, pri obojenju koze. Kist
koji ¢e primarno biti korSten jest ,,Hard Round* kist, a s njim ¢e biti izradene sve vanjske linije,
obojenja i sjene, te ,,Charcoal 24px“ i ,,Stipple 54 px“ koji ¢e se koristiti prilikom izrade skica
zbog njihovih specifi¢nih tekstura koje rezoniraju analogan rad olovkom. Svi kistovi nalaze se u
zadanim kistovima programa, a u oknu ,Brush Presets svim je Kistovima opcija kontrole
veli¢ine kista (Size Jitter) u izborniku ,,.Shape Dynamics* podeSena na ,,Pen Pressure®. Odabrane

boje ikistovi prikazuje Slika 3-2.

3.4.2. Skiciranje, izrada vanjskih linija

Faza skiciranja i izrade vanjskih linija je najzahtjevnija faza izrade zahvaljujuéi ¢injenici kako i
skica i vanjske linije ¢ine kostur ilustracije — skica reflektira dobar ili lo$ koncept, odnosno hoce
li poruka biti efektivno prenesena na S§to utjeCe izbor motiva, kompozicija, linije, odnosi
elemenata isli¢no te definira daljnje korake u izradi putem vizualizacije zavrSnog koncepta, dok
vanjske linije, jednom kad skica nestane, daju zavr§nu formu konceptu, ideji. Ova faza stoga je

oduzela 1 najve¢idio vremena cjelokupnog procesa izrade ilustracija.

Slika 3-3 Skice za ilustracije pjesama ,, Prijatelj , ,, Cekanje “ i ,,Moja Mama

Slika 3-3 prikazuje zavr$ene skice za tri od ukupno Sest ilustracija. Cine ih vanjske linije kojima
su definirani koncept, motivi, odnosi i elementi ilustracije te svijetlosivo obojeni dijelovi koji su
svojevrsni podsjetnik na to koji ¢e dijelovi na finalnoj ilustraciji biti kako obojeni (odabir
svijetlih odnosno tamnih boja), a temeljeni su na odnosima i proporcijama elemenata §to u

kona¢nici pomaze vizualizaciji krajnjeg koncepta.
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Skice za svaku od ilustracija izradene su na layer-u ,skica“ u odgovarajuéem dokumentu te je
pritom koriSten alat Brush i to kistovi ,,Charcoal 24px*“ i ,,Stipple 54 px“kao §to je spomenuto u
poglavlju Postavljanje dokumenta, upravljanje layer-ima, odabir palete boja. Slika 3-4 prikazuje
detalje skica na kojima se moze vidjeti da prilikom izrade nije naroCito pazeno na preklapanje
linija i teksture ve¢ su skice izradivane intuitivno i slobodno, s ¢estim prelazimo kistom vise puta
po jednom dijelu. Pri eventualnim greSkama koristen je alat Eraser postavljen na ,,Hard Round*
Kist.

Slika 3-4 Detalji skica ilustracija za pjesme ,,Moja mama “, ,,Sretan Put“ i ,, Prijatelj “

Kada su sve skice bile izradene, slijedila je izrada vanjskih linija. Skicu je bitno prenijeti u
pravilne i uredne linije , stoga je layer-u ,skica®, koji se prema predlosku hijerarhijski nalazi
ispod layer-a ,,vanjske linije®, postavljena je vidljivost (Opacity) na 50% unutar okna Layers. Na
taj je naCin layer-u ,skica*“ dana transparentnost i ucinjen je svjetlijim Sto je posljedi¢no
omogucilo laksi rad pri izradi vanjskih linija. Vanjske linije izradene su pomocu alata Brush uz
koristenje Kista ,Hard Round*“ kao $to je spomenuto u poglavlju Postavljanje dokumenta,
upravljanje layer-ima, odabir palete boja. Nakon §to su izradene vanjske linije iskljucena je
vidljivost layer-a ,skica*“ u oknu Layers klikom na ikonu oka kraj samog layer-a pa je

posljedi¢no layer ,,vanjske linije* jedini vidljiv. Slika 3-5 prikazuje opisani proces.

Slika 3-5 Proces izrade vanjskih linija na primjeru detalja ilustracije ,,Moje Selo Malo *
Kod izrade vanjskih linija izrazito je paZeno na tijek linija, presijecanje linija i detalje kao Sto je
tekstura dobivena dodavanjem dodatnih linija tocaka i sli¢no. Veli¢ina Kista prilagodavana je u
izborniku kistova koji se otvara desnim klikom na povr$inu dokumenta prilikom koristenja

Brush alata ili putem trake alata pozicioniranog ispod trake izbornika i to prema potrebi, ali u
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pravilu razlika u veli¢ini nije prelazila 10px. Zbog preciznosti koju je bilo potrebno posti¢i nesto
je cesce koristen alat Eraser, brzo mijenjajuc¢i alat Brush s Eraser-om iobrnuto pomo¢u funkcija
same olovke opisane u poglavlju Metode i alati. Kada ve¢i dijelovi izradenih vanjskih linija ne bi
odgovarali zeljenom izgledu, koristen je alat Lasso koji omogucava prostoru¢nu selekciju veceg
dijela linija, koji bi potom bili izbrisani te bi se krenulo s ispravkom izrade vanjskih linija
sliede¢i ranije opisani postupak. Slika 3-6 prikazuje zavrSene vanjske linije za tri od Sest

ilustracija.

Slika 3-6 Vanjske linjje ilustracija za pjesme ,,Moje Selo Malo “, ,,Uspomena “i ,,Sretan Put

3.4.3. Dodavanje boje, tekstura i sjena

Pretposljednji korak u izradi odnosi se na dodavanje boje, detalja i sjena te ¢e se u narednim
odlomcima ukratko objasniti svaki aspekt ovog koraka zasebno. Isprva je odraden prvi korak,
dodavanjem boja. Sve boje dodane su na layer ,boja“ koji se hijerarhijski u predlosku nalazi
ispod layer-a ,vanjske linije*. Ova sistematizacija uvelike pomaze u izradi, naroito brzini
izrade, radi ¢injenice kako je potreba za velikom precizno$¢u prilikom obojenja otklonjena.
Proces obojenja prikazuje Slika 3-7. Eyedropper alatom uzeta je Zeljena boja iz definirane palete
boja te su pomocu alata Brush ispunjena manja podrucja obojenja. Za veca podrucja takoder je
koristen Eyedropper alat, no u ovom slucaju alatom Brush samo su ispunjeni rubni dijelovi
podrucja za ispunjenje te su potom uz pomo¢ alata Paint Bucket znatno brze ispunjena Zeljena
podrucja. U ovom se koraku kao 1 prethodnom, takoder cesto Koristio alat Eraser kada bi se

kistom obojila nezeljena podrucja.
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Slika 3-7 Proces primarnog obojenja na primjeru detalja ilustracije za pjesmu ,, Prijatelj

Kada je obojenje svih podrucja bilo zavrSeno sagledan je kontrast svijetlo i tamno te
kromati¢nost obojenih podrucja i1 njihove odnose. Nerijetki je sluc¢aj bio da se osjecao nesklad pa
bi se javila potreba za obojenjem odredenog podrucja u neku drugu boju. To bi bilo u¢injeno na
na na¢in da se pomo¢u Magic Wand alata selektiralo podru¢je obojeno bojom koja se treba
promijeniti, Eyedropper alatom odabrala bi se zamjenska boja te bi se uz koristenja Paint Bucket
alata obojilo to podrucje u novo odabranu boju. Slika 3-8 prikazuje detalje zavrSenog obojenja za

tri od Sest ilustracija.

Slika 3-8 Detalji obojenja ilustracija za pjesme ,, Prijatelj ©, ,, MojaMama “ i,, Moje Selo Malo “

Potom je uslijedila druga etapa ovog koraka, odnosno dodavanje detalja, ¢ime se u principu
naziva dodavanje uzoraka i tekstura ilustraciji. Svi su detalji odredene ilustracije dodani na
layer-u ,detalji“ koji je u hijerarhijskom poretku layer-a iznad layer-a ,boja“, odnosno njegova
je clipping maska - dakle sve $to ¢e biti izradeno na layer-u ,detalji” biti ¢e vidljivo jedino na
layer-u ,boja“. Proces dodavanja tekstura u pravilu je bio sljede¢i — na layer-u ,boja‘“ alatima
Magic Wand ili Quick Selection odabrana su podruc¢ja na koja ¢e se dodati detalji, a temelji se na
obojenju tog podrucja, potom kada je selekcija ispravno napravljena, aktiviran je layer ,boja“ te
odabran alat Brush, alatom Eyedropper bi se izabrala Zeljena boja iz definirane palete, te krenulo
s izradom detalja. U slu¢aju nezadovoljstva dodanim detaljima, na isti bi Se nacin obrisalo
u¢injeno, ali uz koristenje alata Eraser umjesto alata Brush. Slika 3-9 prikazuje zavrSenu fazu

dodavanja detalja za tri od Sest ilustracija.
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Slika 3-9 Dodavanje detalja ilustracijama pjesama ,,Moje Selo Malo “, ,,Uspomena “i ,, Sretan put

Posljednja etapa ovog koraka jest dodavanje sjena. Sve sjene izradene su uz koriStenje alata
Brush, to¢nije ,Hard Round* kista na layer-u ,sjene* koji se hijjerarhijski nalazi ispred layer-a
»boja“i ,detalji” te kao ipotonji¢ini clipping masku layer-u ,boja“. Slika 3-10 prikazuje proces
dodavanja sjene. Isprva je pomoc¢u Eyedropper alata odabrana iz definirane palete boja, boja koja
¢e biti koriStena kao boja sjene na svih ilustracijama, potom su Brush alatom obojena odredena
podruc¢ja na kojima ¢ée se sjena pojavljivati te su podru¢ja u slucaju pogreske brisana alatom
Eraser, ponavljajuci postupak tako dugo dok izgled ne bi bio zadovoljavaju¢i. Nadalje, kako bi
se postigla vjerodostojnost dodane sjene, layer-u ,sjene” promijenjen je Blending Mode u

LMultiply“ u oknu Layer te mu vidljivost podesena na 25%.

A/ )

Slika 3-10 Proces dodavanja sjene prikazan na primjeru detalja ilustracije pjesme ,, Uspomena *

3.4.4. Dodatna podeSavanja i izvoz ilustracija

Posljednji korak izrade ilustracija odnosi se na dodatna podeSavanja te naposljetku i izvoz
gotovih ilustracija. Dodatna podeSavanja u ovom se slucaju odnose na izoStravanje ilustracija,
dodavanje teksture ilustraciji, te krajnje i pretvaranje ilustracije u akromatski sustav boja kao sto

je definirano u ciljevima rada u poglavlju Ciljevi rada.
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Isprva su spojeni svi layer-i koji ¢ine ilustraciju. Kako bi se sacuvali nespojeni layer-i za
moguénost prepravljanja gresaka i eventualnih promjena, grupu layer-a "ilustracija” duplicirana
je pomoc¢u naredbe Layer » Duplicate Group. Layer-i unutar kopije grupe layer-a potom su
spojeni klikom na CtrHE $to je naredba za "Merge Group" koju se moze naéi u izborniku okna
Layers te ako se klikne na Layer » Merge Group. Novo spojene layer-e, koji sada ¢ine jedan

jedinstveni layer preimenovanisu u "ilustracija".

Novi layer ,,ilustracija, koji sadrzi sve elemente ilustracije (boju, vanjske linije, detalje isjene)
potom je izostren. Funkcija koja je koriStena jest Filter » Sharpen » Smart Sharpen kojom se
otvorio novi prozor "Smart Sharpen” u kojem je omoguéeno upravljanje postavkama
izoStravanja. Slika 3-11 prikazuje odabrane postavke u oknu prilikom izoStravanja svih
ilustracija. Koli¢ina (Amount) podesena je na 80% te radijus (Radius) na 5px. Zadnji prikaz na

slici pokazuje rezultat izoStravanja.

Cancel
[ Preview

@Basic (O Advanced

Amount: %

Radius: pX
—

rgle:| 0

More Accurate

Slika 3-11 Postavke ,,Smart Sharpen “ i rezultat izoStravanja prikazan na detalju ilustracije pjesme
»Moja Mama **

Nadalje ilustracijama je dodana tekstura. Besplatna tekstura skinuta je s bloga grafickog
dizajnera Chrisa Spoonera "Spoon Graphics™ [29] koja dolazi u paketu besplatnih resursa
prilikom prijavljivanja na njegov newsletter. Tekstura koja je koriStena nalazi se u mapi "Grain
Textures”, konkretno tekstura "Grain Texture 09". Klikom na File » Place umetnuta je tekstura u
dokument te je rasteriziran novo stvoreni layer naredbom Layer » Rasterize » Smart Object.
,Blending Mode* layer-a promijenjen je na ,Soft Light te vidljivost podesena na 30%.
Naredbom Ctrl+Shift+G layer je pretvoren u clipping masku layer-a "ilustracija" kako bi se
tekstura prikazivala samo na tom layer-u. Slika 3-12 prikazuje rezultat dodavanja teksture

zajedno s hijerarhijom layer-a nakon dodavanja teksture.
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Slika 3-12 Dodavanje teksture prikazano na detalju ilustracije pjesme ,, Moje Selo Malo “

Sljedeci korak bio je pretvaranje ilustracija u akromatski sustav boja §to ¢e znacajno utjecati na
uStedu prilikom izdavanja zbirke pjesama u tiskanom izdanju. llustracije su pretvorene u
akromatski sustav boja tako da je dodan , Adjustment Layer* i to "Black and White".
»Adjustment Layer dodan je na nacin da je u izborniku desno kliknuto na Adjustments » Black
and White ¢ime se otvorilo okno u kojem se upravljalo postavkama prilagodbe. Nadalje, ovaj
wAdjustment Layer takoder je postavljen kao clipping maska na layer ,.ilustracija®. Slika 3-13

Slika 3-13 Pretvaranje ilustracije u akromatski sustav boja prikazano na primjeru ilustracije za pjesmu
,»Moja Mama

Naposljetku, posto je zavrSen svaki korak u izradi za svaku od Sest ilustracija, do$lo je vrijeme
da se same ilustracije izvezu iz programa ito u JPEG (.jpg) i Photoshop PDF (.pdf) formatu za
kromatske te ilustracije u akromatskom sustavu boja. Kromatske ilustracije ostavljene su u RGB
sustavu boja, poSto ¢e se iste prikazivati na ekranima u elektronickoj verziji zbirke pjesama, a
akromatske c¢e biti potrebno pretvoriti u CMYK sustav boja posto ¢e se iste izdati u tiskanom
izdanju. Prilikom spremanja pazeno je na vidljivost pojedinih layer-a, na primjer Adjustment
Layer za pretvaranja ilustracije u akromatski sustav imao je isklju¢enu vidljivost prilikom
spremanja kromatskih ilustracija i slicno. Kromatske ilustracije izvedene su klikom na File »

Save As te je u novo otvorenom oknu odabran format file-a ,JPEG®, a u opcijama okna koje se
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otvara prilikom spremanja u JPEG, podeSena je najveca kvaliteta spremanja zapisa. PDF format
ilustracije u kromatskom sustavu boja spremljene su klikom na File » Save As te je kao format
odabran ,,Photoshop PDF*. U oknu sa postavkama spremanja u izborniku ,,Adobe PDF Preset*
odabrana je opcija "High quality print”, a ostale postavke ostavljene su prema zadanim
postavkama. Nadalje, kako bi se izvezle ilustracije u akromatskom sustavu boja, kao $to je
reCeno, trebala je promijeniti sustav boja za izvoz u CMYK sustav boja. To je u¢injeno na naéin
da su duplicirani svi layer-i grupe "ilustracija” i njegove clipping maske su pomoc¢u naredbe
,Merge Layers® ili Ctrt-E spojeni. Potom je u izborniku Image odabran Mode te CMYK
(Image » Mode » CMYK). Sada je ilustracija bila u ispravnom sustavu boja za tisak te su iz
programa izvezene u JPEG i PDF formatu, $to je u¢injeno slijedec¢i korake za izvoz kromatskih
ilustracija opisane ranije. Prilog 2 — Zavrsene ilustracije pjesama sadrzi zavrene ilustracije svih
pjesama u kromatskom i akromatskom sustavu boja.

3.4.5. lzradailustracije za omot zbirke pjesama

Posljednji zadatak prakticnog djela jest izraditi omot zbirke pjesama. Isprva je otvoren novi
dokument — dokument je nazvan ,,omot*, veli¢ina dokumenta postavljena je na A5 te je odabran
RGB sustav boja. Potom su, kao i u izradi ilustracija u dokumentu otvoreni svi potrebni layer-i i
definirana je njihova hijerarhija na sljede¢i na¢in - na samom dnu nalazi se layer ,pozadina®,
posto ¢e omot imati pozadinu u nekoj boji, layer ,skica“ na kojem ce biti izradena skica
ilustracije, potom grupa layer-a ,,ilustracija“ koja sadrzi layer-e “boja‘“ i njegovu clipping masku
,sjene te layer ,,vanjske linije“. Takoder je u dokument umetnuta tekstura ,Grain Texture 09,

ista koja je koriStena pri izradi ilustracija.

Proces izrade slijedio je korake izrade ilustracija — skiciranje, izrada vanjskih linija, dodavanje
boje, dodavanje sjena te dodatna podeSavanja i izvoz ilustracije. Isprva je skiciran koncept na
layer-u ,skica®“. Svi dijelovi naslovnice biti ¢e ilustrirani, ukljuCujuéi tekstualne dijelove,
odnosno naslov same zbirke pjesama i ime autorice uz koriStenje motiva iz prirode, posto se isti
motiv provla¢i kroz sve izradene ilustracije. Za skiciranje je koriSten alat Brush i to Kistovi
,Charcoal 24px“ i ,Stipple 54 px* te alat Eraser s kistom postavljenim na ,Hard Round“. Kada
je skica bila izradena, layer-u ,,skica“ postavljena je vidljivost na 50%, nakon ¢ega su izradene
vanjske linije na layer-u ,,vanjske linije* unutar grupe layer-a ,,ilustracija®. Pri izradi vanjskih
linija koriSten je alat Brush i to kist ,,Hard Round* postavljen na boju jednaku boji vanjskih linija
svih ilustracija. Pri eventualnim pogreskama, koriSten je alat Eraser ili pak Lasso, ovisno o

veli¢ini podru¢ja linija koje nisu bile zadovoljavajuce izradene. Po zavrSetku izrade vanjskih
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linija slijedio je korak dodavanja boja. Isprva je naredbom File » Place uvezena slika sustava
boja, koja je ranije spremljena u mapu, sto je omogucilo koristenje istog spektra boja kao pri
izradi ilustracija. Odabrana je plava boja iz tercijarnog spektra boja i na layer-u ,pozadina“
pomocu alata Color Picker i potom Paint Bucket obojena je pozadina. Potom su pomocu alata
Brush, Eraser, Color Picker i Paint Bucket obojena preostala podru¢ja na layer-u ,boja“ na
nacin opisan u poglavlju Dodavanje boje, tekstura i sjena. Slika 3-14 prikazuje opisani proces
izrade ilustracije od skiciranja, izrade vanjskih linija do dodavanja boje.
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Slika 3-14 Proces izrade ilustracije za omot zbirke, od skiciranja, izrade vanjskih linija do dodavanja

boje
Nakon $to su ilustraciji dodane sjene na naéin jednak opisanom u poglavlju Dodavanje boje,
tekstura i sjena, spojeni su svi layer-i koji ¢ine grupu layer-a ,,ilustracija®. llustracija je izoStrena
koriste¢i naredbu Filter » Sharpen » Smart Sharpen kojom se otvorio novi prozor "Smart
Sharpen™ u kojem je omoguéeno upravljanje postavkama izoStravanja. Postavke izoStravanja
ostavljene su jednake onima prilikom izoStravanja ranijih ilustracija. Ukljucena je vidljivost
layer-a ,Grain texture 09 sa teksturom, ,,Blending Mode* postavljen je na ,Soft Light“ te
vidljivost smanjena na 30%. Naredbom Ctrl+Shift+G layer je pretvoren u clipping masku layer-
a "ilustracija” kako bi se tekstura prikazivala samo na tom layer-u. Posljednji korak bio je izvoz
ilustracije iz programa. Posto ¢e omot u elektroni¢kom i tiskanom izdanju zbirke biti u boji
slijedena je metoda izvoza opisana u poglavlju Dodatna podesavanja i izvoz ilustracija za izvoz
tiskanog i elektronickog izdanja. U Prilog 3 — Naslovnica nalazi se zavr$na ilustracija omota

zbirke pjesama.
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4. Analiza rezultata

Prakticni dio, koji je ukljuCivao izradu popratnih ilustracija za Sest pjesama iz zbirke te
ilustraciju same zbirke izraden je u potpunosti u programu Adobe Photoshop. Ovaj alat bio je
samodostatan za izradu zbog koli¢ine i prirode samih alata koje program posjeduje kao §to je
objasnjeno u poglavlju Primjena Photoshopa u ilustraciji. Photoshop je stoga odli¢an program
za izradu ilustracija, Sto dokazuje 1 njegova u€estalost u koriStenju jednako kod profesionalnih
kao iamaterskih ilustratora. Alati, poput bazicnih Brush iEraser alata, uspje$no simuliraju inace
analogne tehnike crtanja, uz Sto jo§ 1 nude Siroku paletu kistova, §to omogucuje oponaSanje
drugih tehnika likovnog izrazavanja (poput slikanja temperom ili akrilnim bojama) tako
postizu¢i kompleksnost samih radova - sve to u samo jednom programu. Njegova paleta Layers,
koja omogucuje slojevitu izradu, uvelike pomaze pri radu, editiranju i upravljanju krajnjim
izgledom ilustracije. Nadalje, kao §to je reCeno u poglavlju Graficki tableti, pomagala poput
grafickih tableta, klju¢na su komponenta za izradu ilustracija, pri ¢emu Photoshop pruza
kvalitetno 1 intuitivno okruzenje za stvaranje, ¢ine¢i svoje platno 1 alate gotovo nalik papiru i

olovci pri analognoj izradi ilustracija.

U poglavljima Teorijske definicije te Uloga, znanje i vjestine ilustratora objasnjeno je kako je
zadatak ilustratora unijeti zivot i vizualnu formu nekom tekstu ili poruci putem kombiniranja
vlastitog iskustva s vizualnom reprezentacijom. Citajué¢i Karolinine pjesme, vidljiva je autori¢ina
povezanost s ljudima, zivotinjama, prirodom, fascinacija zivotom i zamjeCivanje detalja koji
zivotopisno opisuju njene emocije i stanja. Kako bi se takav tekst prenio vizualnom
reprezentacijom koriSteni su upravo motivi ljudi i ljudskih stanja iskazanih njihovom
ekspresijom, provuceni su motivi iz prirode kroz ilustracije svih pjesama, te im dodati detalji koji
su referenca na Karolinin pristup Zivotu koji se o€ituje upravo u zamje¢ivanju malih detalja iz

svakodnevnog zivota.

Proces izrade ilustracija trajao je ne$to dulje od predvidenog, ukupno tri tjedna. Razvoj koncepta
najtezi je korak stoga je najviSe vremena utroSeno na efektivan prijenos motiva i izrecenog u
pjesmama u ilustracije koje ¢e sve to obujmiti. Uz to, posto se radi o zadatku koji zahtjeva veci
broj ilustracija, sve ilustracije stilski su i izriajno trebale pripadati istom svijetu. Zbog te
¢injenice, cijeli tijek izrade ilustracija bio je podijeljen u nekoliko koraka, $to je omoguéilo
stvaranje zajednickog jezika svih ilustracija. Kao $to je receno u poglavlju Skiciranje, izrada
vanjskih linija, osmi§ljavanje samog koncepta ilustracije za pojedinu pjesmu, oduzelo je najvise
vremena upravo radi cinjenice kako su skica i1 vanjske linije, ono S$to ¢e utjecati na

uspjesSno/neuspjesno oblikovanje koncepta u prenoSenju poruke pjesme. Dodavanje boja, detalja,
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sjena i dodatna podesavanja mnogo su krace trajali — sluze samo kako bi dali dodatnu vrijednost
dobro/ lose izradenom konceptu koji se o¢ituje u vanjskim linijama ilustracije putem prenesenih

motiva, odabira likova 1 njihovih polozaja iekspresija.

Slika 4-1 Prototip tiskanog izdanja zbirke pjesama prikazan na primjeru ilustracija i pjesama “Moja
Mama “ i ,,Moje Selo Malo “
Slika 4-1 prikazuje prototip tiskanog izdanja dok Slika 4-2 prikazuje prototip elektroni¢nog

izdanja zbirke pjesama, a oba su prikaza takoder izradena u Photoshopu. Kako je zadatak
zahtijevao izradu ilustracija u dva sustava boja prema njihovoj namjeni, one nalaze svoju
primjenu u izdanju zbirke pjesama u dva razli¢ita medija. Cijena prvog tiskanog izdanja iz 2011.
godine, s drugim izdanjem stoga se neée drasticno mijenjati posto neée biti potrebe za tiskanjem
stranica uboji. S druge strane, elektroni¢ko ¢e izdanje na¢i svoje izdavanje u besplatnom obliku,

uz moguénost donacije u proizvoljnom iznosu.

)

Slika 4-2 Prototip elekronickog izdanja zbirke pjesama prikazan na primjeru ilustracija i pjesame
“Prijatelj
Izrade ilustracije za naslovnicu zbirke, kao sto je reCeno u poglavlju lzrada ilustracije za omot

zbirke pjesama, bio je posljednji zadatak, posto ista treba biti svojevrstan stilski i izri¢ajni odraz
svih izradenih ilustracija. Slika 4-2 Prototip elektronickog izdanja zbirke pjesama prikazan na

primjeru ilustracija i pjesame ‘“Prijatelj“prikazuje prototip omota zbirke pjesama u tiskanom i
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elektronickom izdanju. Omot je izraden tako da bude, ne samo odraz stila svih ilustracija, ve¢ je
fokus stavljen na to da ne slijedi klasi¢ne obrasce izrade omota knjige ¢ime ¢e potencijalno, zbog

toga Sto je drugaciji, privlaciti paznju gledatelja. 1ztog je razloga ilustriran i sam naslov zbirke.
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Slika 4-3 Prototip omota zbirke pjesama — lijevo za tiskano izdanje te desno za elektronicko izdanje
zbirke pjesama
Cjelokupni je proces izrade bio pouc¢no no i zahtjevno iskustvo. Izraditi seriju od vise povezanih

ilustracija za neki projekt, ¢ini ovaj proces poucnim iskustvom koje u€i o vaznosti planiranja 1
strukturiranja dokumenata i layer-a, o odabiru palete boja i kistova, te efikasnosti koristenja
Photoshopa putem postavljanja radnog okruzenja i njegovih tipkovnickih precaca. Svakako je
ovo i zahtjevno iskustvo, jer je primarna ilustratorova uloga putem ilustracije dati dodanu
vrijednost nekom tekstu, a imati tu privilegiju svakako sa sobom nosi i izazove i odgovornosti,

kako prema tekstu tako i prema samom autoru i ¢itateljima.
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5. Zakljuéak

Adobe Photoshop vodeci je program za obradu slika koji se zbog svoje Siroke palete alata i
mo guénosti primjene pozicionirao kao standard brojnih industrija, a jednako vrijedi i za podrucje
ilustracije. Ilustracija svoj ponovni veliki znacaj stjeCe u digitalno doba, u ¢emu su znacajnu
ulogu odigrali mo¢ni programi za obradu slika, upravo poput Photoshopa. S ulaskom u novi
milenij, zajedno sa kompjuterizacijom i digitalizacijom, ilustratori nalaze svoje mjesto u novoj
digitalnoj eri, a programe poput Photshopa upos$ljavaju u pronalaZzenju novih nac¢ina stvaranja i
prenoSenja poruka. Novi je milenij, naro¢ito s prelaskom iz analognih u digitalne nacine
stvaranja, dao novo svijetlo disciplini ilustracije — ilustratori, koriste¢i nove nacine
komunikacije, kompleksne programe i sve naprednija pomagala, nalaze svoje mjesto u
digitalnom svijetu dominiranom slikom. Primjena ilustracije u brojnim podru¢jima poput
izdavastva, dizajna i oglaSavanja, filmskoj, industriji video igara i poslovnom svijetu svjedoce

vaznosti ilustracije kao suvremenog medija vizualne komunikacije.

Prakti¢ni dio rada nastojao je, kroz primjer izrade Sest ilustracija za zbirku pjesama ,,Budi mi
prijatelj* Karoline Perec te ilustracije za omot zbirke, objasniti proces rada u Photoshopu, koji je
uovoj disciplini nerijetko samodostatan za izradu ilustracije. Iako se prakti¢ni dio rada fokusirao
na tijek rada u programu, objasnio koristene metode i alate te zasebno objasnio svaki korak u
izradi, on ipak nije zaobiSao cjelokupni proces promisljanja irazvoja koncepta. Izrada ilustracija
unutar programa samo je jedan dio u cjelokupnom procesu nastanka ilustracija koje vizualno
komuniciraju neki tekst. Srz ilustracije je kako Lawrence Zeegen tvrdi u promiSljanju, a
ilustracijama je u ovom projektu, vezu¢i se na njegove misli, upravo pokusano to ispunjenje

primarne uloge ilustratora — unijeti Zivot i dati vizualnu formu Karolininim pjesmama.
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7. Prilozi

7.1. Prilog 1 — Odabrane pjesme

PRIJATELJ

Prijatelja jednog imam

Sigurna sam da me voli

Vjerno prati me posvuda
Utjeha je kad me boli

Jednog prijatelja imam
Koji mirno uz nogu svjedi
Gleda me toplo, milo
Kao da mi besjedi

Imam jednog prijatelja
Koji me u Setnju vodi
Zna sve moje misli
Pogada sto mi godi

Prijatelja imam pravog
U igri se sa mnom Sali
A ponekad od puste srece
Sve Sape u zrak izvali

Prijatelja jednog imam
Koji srce mi nikad ne rani
Vec od svakog zla
On hrabro me brani

Imam prijatelja pravog
Koji ljubav u srcu nosi
Za me zivi, sa mnom radi
I moju ljubav prosi

SRETAN PUT

Putnice, podi sa srecom

Kud god da put te vodi

I ne osvréise niza ¢im
Putem sudbine smjerno hodi

Do rijeke kad dodes, pazi
Dubokaje, sirokaje,
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MoJA MAMA

Ti si mi, mama, zZivot poklonila,
I srce moje od zlobe sklonila,
Svojom dobrotom dusu ukrasila,
Zivot od smrti spasila
Sa mnomuvijek si plakala,
O, koliko si za mene patila,
Svu l[jubav meni pruzila,

I za moj se Zivot nebu oduzila
Nikad nisi posustala,
Nikad zlu popustila
O, kako hrabro za me se borila
| pravdu u ruke dobila
Moju povijest, mama, nikad zaboravila,
svo zlo si zgazila
Od sveg svijeta ti si me branila
1 u posljednjem casu spasila
Ne mogu stoga nista drugo reci
Neg':Hvala ti, mama!!!

Jer suze bi mogle poteci
Samo jedno te usrdno molim:
Zaboravi sve ruzno
Jerjate volim

MoOJE SELO MALO

Moje je selo maleno, mirno iveselo,
Ljudi u njemyvrijedni, marljivi,
Zemljicu znojem zalijevaju,
Muku svoju ubiru.

Djecica putem skakucu
Ko vrapci dvoristem
Mmwvicu da nadu.

Moje je selo lijepo i mirisno,
U njem su vrtovi svjezi, Sareni
Tulipani crvenih glava,

A potocnica plava, plava.



Pregazitju ne mozes
Plivat ti je preko nje

K cilju hitaj glave bistre
Suputnik ti nevidljiv, tih
Nagrada je srce Cisto
Ispunjenje Zelja svih

USPOMENA

Kad izgubis voljene i drage
I godine te ostave bez snage
Vrijeme je blago sto lijeci
Kao i prijatelja tople rijeci

Stisak ruke i osmjeh na licu
Za usamljeno srce melem su
A uspomene davne, blijede
Vise od zlata srcu ti vrijede

To je oko koje budno me pazi
To je noga koja umjesto mene gazi
to je zvijezda Sto na nebu za me sja

To je ruka koja njezno me gladi
To je rijec koja pita sto li srce mi radi
To je ruza koja u srcu cvate mom

To je ljubav koja mrznju gasi
To je sreca koja dane mi krasi
To je pjesma koju pjevamo u zboru ti i ja
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1 ptice na granama cvrkucu,
Jedna drugoj pricu pricaju.
Jedan potok zubori i kroz srce
Moga sela prolazi.

Tu vrapcici vodicu piju
1 zdravicu dizu
Za domovinu moju milu.

CEKANJE

Obecao je jednom da ¢e doci
Probudio u meni nadu uspavanu
1 ja ¢u mu u susret poci
Ljubav davnu prizvati tajno
Misle¢ tako u samoci
Zelja mi u srcu gorjet ne prestaje
Jos se nadam strepeci
Da nije zaboravio miris moj

Lutajuc u svojoj nemoci
Trazim uzalud putka svijetlu
Uskoro ée i no¢ beskrajna proci
Ne bih znala sama, al'
Kaze mi ura glasno bijuci
Sve sporije otkucava srce
Nada nestaje polako blijededi
Shvatimda sama sam do Boga

Uzaludnost ponovno budeci
Svijest mi kaze...Nece doci



7.2. Prilog 2 — ZavrSene ilustracije pjesama

ILUSTRACIJE PJESME ,MOJE SELO MALO*

ILUSTRACIJE PJESME ,,USPOMENA*
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ILUSTRACIJE PJESME ,,SRETAN PUT*

ILUSTRACIJE PJESME ,,PRIJATELJ*
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ILUSTRACIJE PJESME ,,CEKANIJE“

ILUSTRACIJE PJESME ,MOJA MAMA*

51



7.3. Prilog 3 — Naslovnica

KAROUNA PEREC )

NASLOVNICA ZBIRKE PJESAMA
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